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Меры безопасности 
 

Перед началом установки изучить информацию ниже, чтобы не допустить 
возникновения потенциально опасных ситуаций. 
Общие меры безопасности 

• Использовать источник электропитания с мощностью, идентичной мощности 
оборудования во избежание поломок и отказа. 

• Убедиться, что вилка устройства полностью вставлена в розетку. Не использовать 
розетку, которая подсоединена не полностью. 

• Не касаться устройства во время грозы. 

• Не перегружать шнур электропитания. 

• Не помещать тяжелых предметов на шнур или вилку электропитания и не допускать 
их повреждения. 

• Не перегибать шнур электропитания и не тянуть за него. 

• Не допускать попадания влаги на устройство, сетевой блок питания, вилку 
шнура. Не касаться их мокрыми руками и не проливать на них жидкость. 

• При обнаружении постороннего запаха, перегреве, обесцвечивании, деформации 
и прочих нестандартных ситуациях отключить сетевой блок питания и прекратить 
эксплуатацию устройства. 

Меры предосторожности при эксплуатации 

• Не эксплуатировать устройство в пыльных помещениях, при высокой 
температуре (более 30 °C) и влажности (свыше 75 % или при приближении 
окружающей температуры к точке росы). 

• Поверхность установки должна быть устойчива, не допускать значительной вибрации. 

• При эксплуатации и хранении устройства избегать воздействия прямых 
солнечных лучей, брызг воды и масел, соленого воздуха и соленой воды, пыли 
и влажности, воспламеняющихся газов и сквозняков. 

• При установке плоттера следить за тем, чтобы места было достаточно. 

• Не касаться листов бумаги и движущихся частей плоттера в процессе работы. 
Необходимо следить, чтобы в плоттер не попали волосы и одежда. 

• Не применять силу и не подвешивать предметы на движущийся рычаг. 

• Отсоединять плоттер от розетки электропитания только за вилку, а не за шнур. 
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【Важная информация】 

• В целях безопасности при перемещении необходимо надежно удерживать 
режущий плоттер за основание. Запрещается перемещать плоттер, удерживая 
его за боковые поверхности. 

 

 
(O) Верно 

Удерживать за дно 
X (Неверно) 

Удерживать за выемки 
по бокам 

 

• Запрещается трясти и бросать держатель ножа — риск отламывания кромки 

• Запрещается касаться движущихся частей плоттера в процессе работы (включая 
каретку). Необходимо следить, чтобы в плоттер не попали волосы и одежда. 

• Кабель электропитания подключать только к розетке с заземлением. 

• Использовать только комплектный кабель электропитания. Следить, чтобы 
кабель электропитания не перекручивался и не застревал между предметами. 

• Запрещается подключать кабель электропитания к сетевому разветвителю, если 
к нему подключено другое оборудование, и использовать удлинительный кабель. 
Это может привести к перегреву и выходу устройства из строя. 

• Инструменты необходимо держать в недоступном для детей месте. 

• Прижимные ролики необходимо выравнивать по белым отметкам. 
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• Запрещается одновременно нажимать верхний и нижний захваты, как на рисунке 
ниже: 

 
O (ВЕРНО) X (НЕВЕРНО) 

 
Нажать: Нажать: 

 

  
 

 
Нажать снизу, 
освободить 
захват 

 

ВКЛЮЧИТЬ 

  

Осторожно 

Примечание. 
Если из-за ошибок в эксплуатации 
захваты застряли в сведенном 
положении, необходимо пинцетом 
вытянуть штангу-упор, 
одновременно нажимая верхний 
захват. Полностью вытянув 
и зафиксировав упор, отпустить 
захваты, как на рисунке справа. 

ОТКЛЮЧИТЬ 
 

Штанга-упор 
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Рабочее пространство 
Подготовить рабочий стол вмещающий плоттер RXII-61 с автоподатчиком. Ширина 
рабочего стола должна быть не менее 1100 мм, длина — не менее 800 мм, высота — 
не менее 600 мм. 
Подготовить три розетки: для RXII, автоподатчика и компьютера. 
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1.1 Общее 
Режущий плоттер AFR-24S, дополненный автоматическим податчиком листов, 
поддерживает биговку листов и укомплектован двойным держателем инструмента 
с усилием реза до 600 гc/м2 и скоростью реза 1530 мм/с. Благодаря цифровому 
устройству подачи листов он может параллельно осуществлять биговку и резку 
в полистном режиме без участия оператора. Это оптимальное решение для 
автоматизированной обработки коротких тиражей и выгодного производства макетов, 
складной картонной упаковки, персонализированных открыток, этикеток и наклеек. 

 
 

1.2 Содержимое упаковки 
В комплект поставки плоттера RX II с устройством автоматической подачи входят 
перечисленные ниже компоненты. Следует внимательно проверить комплектацию, 
и в случае нехватки компонентов обратиться к региональному дилеру. 

 
ТТииппооввааяя  ккооммппллееккттаацциияя ККоолл--ввоо 

1. Режущий плоттер 1 ед. 

2. Модульная опора для гибких материалов 
 
Фланцы для рулонных материалов — 2 шт.  
Держатели рулона — 2 шт. 
Втулки для направляющих держателя рулона — 4 шт.  
Держатели рулона — 2 шт. 
Ключ под внутренний шестигранник Г-образный для винтов M6 — 1 шт.  
Руководство по монтажу стойки — 1 шт.  
Ключ под внутренний шестигранник Г-образный для винтов M5 — 1 шт.  
Настольные опорные кронштейны — 2 шт. 
Пластмассовые ножки — 4 шт.  
Винты M4 — 4 шт.  
Винты M6 — 12 шт. 
Ключ под внутренний шестигранник Г-образный для винтов М4 — 1 шт. 

 
 
 
 
 
 

1 компл. 

3. Дополнительные компоненты 
 
Шнур электропитания — 1 шт. 
Компакт-диск пользователя — 1 шт. 
Кабель передачи данных — 1 шт. (кабель USB длиной 3 м) 
Узел держателя ножа — 1 шт. (устанавливается в каретку режущего плоттера)  
Нож — 1 шт. (устанавливается в держатель ножа) 
Безопасный нож 
Марзан для резки поливинила — 1 шт.  
Пинцет — 1 шт. 
Карта Promise — 1 шт. 

 
 
 
 
 

1 компл. 

Глава 1 Общая информация 
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Упаковка с автоподатчиком 
 

Элемент Кол-во Фото 
 
 
Автоподатчик 

 
 

1 шт. 

 

 

Дополнительные компоненты автоподатчика 

Лоток для приема 
материала 1 компл. 

 

 

Левый и правый 
соединительные 
кронштейны 

2 шт. 

 

 

Винт с накатной 
головкой 2 шт. 

 

 

Винт 4 шт. 

 

 

Кабель 
электропитания 1 шт. 

 

 

Кабель RS-232 1 шт. 

 

 

Руководство по 
установке 1 шт. 

 

 

Упоры для материала 2 шт. 
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1.3     Общие сведения об устройстве 
1.3.1 Режущий плоттер AFR-24S 

 
 

 
 
 

Элемент Функция 

Соединитель 
последовательного 
интерфейса 
RS232C 

Подключение режущего плоттера к компьютеру 
через кабель последовательного интерфейса 
(RS232) 

Упор Выравнивание материала 

Лоток для 
материала 

Загрузка материала для последующей обработки. 

 
Раздув Подача воздуха для отделения материала 

с предотвращением двойной подачи. 
 
Магнитный 
отделитель 

Разделение материала с предотвращением 
двойной подачи при загрузке листов 
в режущий плоттер. 

Чашечная присоска 
 

Удерживает материал при загрузке листа 
в режущий плоттер. 

Упор Раздув 

Чашечная присоска 
Лоток для материала 

Соединитель 
интерфейса 
RS232C 
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Элемент Функция 

Разъем питания Разъем для кабеля электропитания. 

Силовой выключатель Включение и отключение автоподатчика. 

Регулируемый лоток 
для материала Для приемки материала после резки. 

 
Раздвижная стойка Выдвигается на нужную высоту, служит 

опорой для лотка. 

 

 

 

 

Приемный лоток 

Раздвижная стойка 

Разъем питания 

Силовой выключатель 
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1.3.2  Общие сведения о режущем плоттере 
 
 

 
 

Элемент Функция 

Силовой выключатель Вкл. [I]; откл. [O] 

Предохранитель 3 А 

Разъем питания Разъем для кабеля электропитания 
 
 
 

 
 
 

Элемент Функция 

Соединитель 
последовательного 
интерфейса RS232C 

Для подключения режущего плоттера 
к компьютеру через кабель 
последовательного интерфейса (RS232) 

 
Порт Ethernet Для подключения режущего плоттера 

по локальной сети 
 
Порт USB Для подключения режущего плоттера 

к компьютеру через кабель USB 

Разъем питания 

Предохранитель 

Силовой выключатель 

Порт USB 

Порт Ethernet 

Соединитель 
последовательного 
интерфейса RS232C 
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1.3.3 Внешний вид AFR-24S 
 
 

 
 
 

 

 

Решетчатые барабаны:  
перемещают материал вперед  
и назад в процессе работы. 
 

Каретка: режет материал при 
установленном ноже, рисует 
пером с модулем AAS. 

Панель управления:  
14 клавиш управления,  
1 светодиодный 
индикатор и ЖК-экран. 

Опорная пластина:  
удерживает материал  
при резке и служит опорой. 

Линейки: для выравнивания 
материала по прозрачным 
меткам направляющих. 

Марзан: защищает нож 
при резке. 

Отрезной паз:  
упрощает срезание  
лишнего материала. 

Прижимные ролики:  
удерживают материал 
при резке. 
 

Рычаг:  
поднимает и опускает 
прижимные ролики. 
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Центр 

Левый 
 

 
 

1.3.2 Прижимной ролик 
В зависимости от типа обрабатываемого материала, для прижимных роликов 
выбирается одна из трех настроек давления. Например, при резке тонких материалов 
типа витринной тонировочной пленки давление центрального прижимного ролика 
должно быть низким. 

 
 
 

   
Низкое Среднее Высокое 

 
 

Важно: давление прижимных роликов слева и справа всегда должно быть таким же 
или выше, чем у центрального ролика. Настройки давления для прижимных роликов 
слева и справа должны быть одинаковыми. Возможные комбинации для прижимных 
роликов. 

 
 
 
 
 
 
 
 
 

Правый 

Левый Центр Правый 

Высокое Среднее Высокое 

Среднее Среднее Среднее 

Среднее Низкое Среднее 
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Модель GCC AFR-24S работает в двух режимах и может использоваться либо 
автономно как стандартный плоттер (RXII-61 Creasing), либо в комплекте 
с автоподатчиком (AFR) для резки листов. 

 
В настоящем руководстве описана установка и эксплуатация стандартного 
плоттера (RXII-61 Creasing) и плоттера с AFR. 

2.1 Подключение режущего плоттера GCC 
Режущий плоттер обменивается данными с компьютером через порт USB (Universal 
Serial Bus), последовательный порт (RS-232C) или Ethernet. В следующем разделе 
рассмотрено подключение плоттера к основному компьютеру, а также настройка 
компьютера и обмена данными с плоттером. 

 

 
 

2.1.1 Подключение по USB 
1. Включить компьютер. 

2. Подключить к устройству кабель USB. Драйвер USB будет установлен 
автоматически. Обнаружение устройства занимает до нескольких минут. 
НЕ ДОПУСКАЕТСЯ отсоединять кабель USB до завершения процесса 
установки. 

3.  Дважды щелкнуть на значке USB на панели задач, убедившись, что 
компьютер распознал устройство. 

 

 
 
 

 
 
 
2.1.1.1 Установка драйвера 
Для быстрой установки драйвера рекомендуется использовать мгновенную 
установку. Для настройки выполнить перечисленные ниже шаги. 

 

 

Внимание! 
 
 Если на компьютере установлена ОС Windows 7 и выше, 

в систему входить через учетную запись с правами 
администратора. 

 
Примечание: 
1. При установке соединения через USB последовательный порт отключается 

автоматически. 
 

Раздел 2 Установка 
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Шаг 1 Вставить установочный диск DVD в устройство чтения компакт-дисков.  
Перед началом установки драйвера убедиться, что USB-устройство 
подключено. 
 

Шаг 2 Выбрать из списка драйверов нужную модель и нажать Windows Driver 
(Win 7 and Above) (Automatic Detection) или Windows Driver (Win 7 and Above) 
(Manual Selection), чтобы установить драйвер и модуль AAS. 

 

  
 

Шаг 3 Запустить установку драйвера, нажав Next. 
 

 
 

Шаг 4 Для установки драйвера пользователям Windows 7 и выше необходимо нажать 
на красную ссылку и прочесть, как отключить функцию обновлений Windows Update. 
Нажав OK, перейти к следующему шагу. 
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Шаг 5 Убедившись, что питание включено и плоттер подсоединен к разъему USB, 
нажать кнопку OK. 

 

  
 

Шаг 6 Перед началом установки подтвердить закрытие работающих программ 
и нажать OK. 

 

 
 
 

Шаг 7 Установка занимает несколько минут. По окончании установки на экране 
появится следующее сообщение, под которым нужно нажать ОК. Надеемся, вам 
понравится работать с плоттером GCC! 
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Шаг 8 Чтобы установить AASII VBA в ПО CorelDRAW и Adobe Illustrator, закрыть 
CorelDRAW и Adobe Illustrator и нажать кнопку Install. 

 

 
 
 

Шаг 9 Проверить версии CorelDRAW и AI в окне Install Message, затем нажать OK. 
 

 
 

Примечание 
(1) При повторной установке пользователю необходимо подтвердить, нужна ли 

ему копия уже установленного драйвера. 
 

 
 

(2) При выборе опции Yes будет установлена еще одна копия драйвера. 
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(3) Пользователям, обновившим Adobe Illustrator или CorelDRAW, нужно открыть 
вкладку AAS Installer в окне Свойства принтера и нажать Install (Установить), 
чтобы получить доступ к последней версии модуля GCC AAS. 

 

 
 

2.1.1.2 Удаление драйвера 

Перед установкой новой версии драйвера с компьютера необходимо полностью 
удалить предыдущую версию. Процедура удаления описана ниже. 

 

Шаг 1 Выполнив Control Panel > Hardware (Панель управления > Оборудование 
и звук), открыть окно Sound\Devices and Printers (Просмотр устройств и принтеров). 
Щелкнув правой кнопкой мыши на принтере, выбрать Remove device (Удалить 
устройство). 
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Шаг 2 После удаления устройства щелкнуть на любом принтере в окне и выбрать 
Print server properties (Свойства сервера печати) — для Windows 7 и выше) или 
щелкнуть на пустом месте окна и выбрать Print server properties (для Windows XP) 

 

 
 

 
Шаг 3 Перейти на вкладку Drivers. 
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Шаг 4 Выбрав нужную модель, нажать Remove (Удалить). 
 

 
 
 

Шаг 5 Выбрав Remove driver and driver package (Удалить драйвер и пакет драйвера), 
нажать кнопку OK. 
 

 
 
 

Шаг 6 Выбрать Yes, нажать кнопки Delete и OK. Установленный драйвер будет 
удален с компьютера. 
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2.1.2  Подключение по RS-232 

 
Подключение к порту RS-232 (последовательному) 

 
1. Для пользователей IBM PC, PS/2 и совместимых устройств: подключить 

кабель RS-232C к нужному последовательному порту (COM1 или COM2) 
главного компьютера. 

 
2. Настроить параметры обмена данными (Baud Rate (Скорость бит/с) и Data 

Bits/Parity (Кол. бит /четность)) в соответствии с параметрами ПО. См. 
раздел 3 — описание клавиши Misc. 

 

 
 

2.1.3  Подключение по Ethernet 
A. Настройка сетевого подключения 

Шаг 1 Соединить порт LAN и порт Ethernet режущего плоттера GCC 
Ethernet-кабелем RJ45 и включить устройство. 

 

  
 
 

Шаг 2 Нажать On/Off line, затем кнопку MISC на панели управления. 
 

  

1 

2 

Осторожно! Отключить плоттер перед подсоединением кабеля RS-232C. 
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Шаг 3 На вкладке DHCP кнопками со стрелками вверх и вниз выбрать Enable 
и нажать Enter. 

 

  
 
 

Шаг 4 IP-адрес будет автоматически выведен на экран. Его необходимо записать. 
 

 
 

B. Настройка подключения Ethernet 
Имеется два способа вывода файлов через Ethernet. Если файл создан в GreatCut, 
придерживайтесь инструкции I. Вывод через GreatCut. Если файл создан в Adobe 
Illustrator or CorelDRAW, придерживайтесь инструкции II. Вывод через драйвер 
Ethernet. 

 
 

 

Настройка Ethernet для GreatCut 
 
Шаг 1 Открыть GreatCut, создать новый файл и линию реза. 

 

 
  

I. Вывод через GreatCut 
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Шаг 2 В разделе Settings найти Output Devices (Устройства вывода). 
 

 

 
Шаг 3 В списке Driver окна Setup Device выбрать нужную модель. 

 

 

 
Шаг 4 В поле TCP/IP ввести IP-адрес, скопированный с панели управления. 

Завершить настройку кнопкой ОК. 
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Шаг 5 В меню File выбрать Output и проверить параметры. 
 

  
 

 
Завершить установку драйвера. Теперь для режущего плоттера GCC доступны 
сетевые подключения. 

 

Примечание. Чтобы добавить новое локальное устройство, в окне Settings перейти 
в раздел Output Devices и выбрать Add local device (если устройство 
установлено, но нужно выбрать другое устройство, нажать Change 
и указать IP-адрес другого устройства). 
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Шаг 1 Подсоединить кабель Ethernet к компьютеру и установить драйвер Cutter 
Ethernet. Чтобы продолжить, нажать кнопку OK. 

 

 
 
 

Шаг 2 Ввести IP-адрес с панели управления и выбрать модель (см. раздел 1 
настоящего руководства). 

 

 
 
 

Шаг 3 Драйвер установлен. Теперь можно отправлять на вывод файлы из AI 
и CorelDRAW. 

 

 
 

2.1.4 Передача данных 
Передать данные с компьютера на режущий плоттер можно двумя способами. 

 
Вариант 1.  При правильно настроенных параметрах можно передавать данные 

из программы прямо на режущие плоттеры. 
Вариант 2. Практически все программы поддерживают эмуляцию команд HP-GL 

и HP-GL/2. Если файл в формате HP-GL или HP-GL/2, ошибки при выводе 
на режущем плоттере исключены. 

  

II. Вывод через драйвер 
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2.1.5 Настройка общего доступа 
На компьютере A-PC настроить драйвер принтера как общий принтер, затем 
использовать компьютер B-PC для подключения к принтеру A-PC через Intranet. 

 

 
 
 
 

Шаг 1 На компьютере A-PC настроить драйвер принтера как общий принтер. 
Щелкнуть правой кнопкой мыши на значке принтера, выбрать Printer properties 
(Свойства принтера). Нажать Sharing (Общий доступ), затем Share this printer 
(Общий доступ к принтеру). 

  
 
  

Intranet 

Порт USB или COM 

A-PC B-PC 
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Шаг 2 На вкладке Advanced выбрать Print directly to the printer. 
 

 
 

Шаг 3 Отправить задание с компьютера A-PC на устройство, чтобы проверить, 
подключен ли к устройству компьютер A-PC. 

 
Шаг 4 Активировать драйвер принтера для компьютера A-PC через сеть B-PC. 
 

 

   
 
 

Шаг 5 Правой кнопкой мыши щелкнуть на значке принтера и выбрать Connect 
(Подключить) для принтера A-PC. 

 

 
 
 
 
 
 

Отправить 
задание, чтобы 
проверить работу 
порта. 



30 

AFR-24S. Руководство 
 

 

 

2.2  Установка автоподатчика 
1. С помощью правого и левого соединительных кронштейнов с двух сторон 

автоподатчика зафиксировать его винтами на плоттере. 
 

  
 
 

2. Затянуть винтами с накатной головкой соединительные кронштейны на боковой 
стенке плоттера AFJ-24S. 

 

  
 
 

3. Ослабить винты на боковых кронштейнах автоподатчика. 
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4. Выдвинуть боковые кронтшейны до контакта с плоттером, затем затянуть 
винты. 

 

  
 
 

5. Ослабить винты на тыльной стороне корпуса. 
 

 
 

6. Зафиксировать соединительный кронштейн на тыльной стороне корпуса винтами. 
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7. Закрепить лоток для приема материала на соединительном кронштейне. 
 

 
 
 

8. Убедиться, что раздвижные стойки по обеим сторонам касаются пола 
и поддерживают лоток. 

 

 
 

9. Вставить стопор для материала в пазы лотка. Стопор фиксируется магнитом. 
Отрегулировать положение стопора в зависимости от размера обрабатываемого 
материала. 
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2.3 Установка магнитного отделителя листов 
Магнитный отделитель предотвращает двойную подачу при загрузке листов в режущий 
плоттер. 
 

 
 

Отделитель крепится к податчику с помощью находящегося в нем магнита. При 
необходимости магнитный отделитель можно передвинуть в другое положение. 
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2.4 Установка ножа 
Нож вставляется в нижнюю часть держателя. Для извлечения необходимо нажать 
на штифт. Запрещается касаться острия ножа пальцами. 

 
 

Головка винта 
регулировки высоты 

Штифт 

 
 
 
 

Внешнее кольцо 
 
 
 
 

Шаг 1 Установить нож. 
 

 
 

Шаг 2 Протолкнуть нож в нижнюю часть держателя. 
 

 
 

Шаг 3 Отрегулировать вылет ножа, поворачивая винт регулировки ножа по часовой 
или против часовой стрелки. 

  

Совет 
Оптимальной высотой режущей части считается 
лезвие, вылет которого на 0,1 мм больше толщины 
пленки. Если толщина пленки составляет 0,5 мм, 
вылет ножа необходимо установить на 0,6 мм, чтобы 
нож полностью прорезал пленку, но не подложку. 
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Шаг 4 Вставить держатель ножа в каретку. Убедившись, что внешнее кольцо 
держателя надежно входит в желоб каретки, закрыть крышку. 

 

  

 
Шаг 5 Для демонтажа держателя выполнить шаги в обратном порядке. 

 

Шаг 6 Извлечение ножа. Чтобы извлечь нож, подлежащий замене, нажать 
на «Штифт для извлечения ножа». 

 

Внимание 
Спустя определенное время эксплуатации нож утрачивает остроту; это может 
повлиять на качество реза. Компенсировать этот эффект можно увеличением усилия 
реза. Но если нож изношен и режет нестабильно, его следует заменить новым. 
Нож — это расходный материал. Для обеспечения качества реза его необходимо 
заменять так часто, как потребуется. Качество ножа существенно влияет на качество 
реза. Для достижения хороших результатов следует использовать ножи высокого 
качества. 
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Автоматическое определение длины ножа 
На фото показан новый держатель ножа со шкалой и каретка с меткой. Вылет ножа 
в держателе определяется автоматически. На шкале будет показано, насколько 
нужно повернуть регулировочную головку. 

 

 
 

На шкалу нанесено 10 делений. Каждое соответствует 0,05 мм. Соответственно, 
высота ножа регулируется в пределах от 0,00 до 5,00 мм. 

 
Чтобы отрегулировать вылет ножа: 

1. До начала регулировки режущая часть должна оставаться внутри держателя. 

2. Одну из меток на держателе ножа выровнять по метке на каретке. 

3. В разделе CUT TEST (Тестирование реза) выбрать Blade Length Adjust 
(Регулировка выступающей части). Ввести нужный вылет ножа в поле Set Length, 
проверить держатель ножа, затем нажать ENTER, чтобы проверить вылет. 

 
Примечание При проверке держателя ножа и вылета держатель должен оставаться 
в одном положении. 

1 единица 

Деление 
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4. По завершении проверки на экране будет показано, на сколько делений (число 
после обозначения CW или CCW) и в каком направлении [CW (по часовой 
стрелке) или CCW (против часовой стрелки)] повернуть регулировочную головку. 

Например, Turn CW 5 означает «повернуть ручку на 5 делений по часовой стрелке». 
 
 

  
 

5. Когда значение на экране будет равно 0, система выведет сообщение Adjustment 
complete (Регулировка завершена). Вылет ножа оптимален и не требует 
корректировки. Нажать Enter, чтобы завершить настройку и приступить к резке. 

  



38 

AFR-24S. Руководство 
 

 

 

2.6 Установка биговочного инструмента 
 

Шаг 1 Снять с каретки биговочный инструмент и держатель. 

 
 
 

Шаг 2 Убедиться, что цилиндр находится в положении «Вверх». 
Нажимая на цилиндр, поддерживать модуль за нижнюю часть, фиксируя 
модуль и одновременно сжимая, как на рисунке ниже. 

  
 

Шаг 3 Вставить биговочный инструмент в корпус держателя. 

 

Вниз Вверх 
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Шаг 4 Убедившись, что инструмент вставлен до упора, зафиксировать его вращением 
винта. 

 

 
 
 
 

Шаг 5 Поместить регулировочный калибр по месту расположения биговочного 
инструмента и вставить держатель. (Предварительно убедиться, что цилиндр 
находится в положении «Вверх») 

 

 

Нажать на кончик 
инструмента, 
убедившись, что он 
вставлен в корпус. 

Зафиксировать 
вращением винта. 
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Шаг 6 Нажимая на верхнюю часть биговочного инструмента и удерживая нижнюю часть 
цилиндра, отрегулировать высоту. 

 

 
Шаг 7 Поворотом нижнего винта зафиксировать положение биговочного инструмента 

и держателя. 
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2.7 Установка программного обеспечения 
2.7.1  Установка ПО GreatCut 
Шаг 1 На установочном диске выбрать опцию GreatCut Registration. На веб-сайте 

http://gccvoucher.eurosystems.lu/ ввести код с купона, полученного при покупке 
GreatCut, и нажать Go on! 

 

 
 
 
 

 

 
 
 
 

Шаг 2 Кнопкой Request (Запрос) перейти на страницу регистрации. 
 

 

http://gccvoucher.eurosystems.lu/
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Шаг 3 Ввести нужную информацию и нажать Request license code (Запросить код 
лицензии). 

 

 
 

Шаг 4 Регистрация завершена. По электронной почте будет отправлено два 
сообщения: первое с подтверждением регистрации и ссылкой для активации, 
второе — с данными лицензии в формате .ecf. 

 

 
 
 

Шаг 5 Получив письмо с ссылкой для активации, щелкнуть по ссылке и скачать 
программу GreatCut. 
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Шаг 6 Или выбрать Install GreatCut из меню установочного диска DVD. 
 

 
 

Шаг 7 Указать папку для установки. 
 

 
 
 

Шаг 8 Выбрать Typical (Стандартная установка) и нажать Next. 
Примечание. Для установки дополнительных драйверов выбрать Сustom 
(Пользовательская установка). 
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Шаг 9 Указать нужную папку и нажать Next. 
Папка для установки по умолчанию в меню Пуск: GCC/GreatCut 3. 
 

 
 

Шаг 10 Программа GreatCut устанавливается на компьютер. 
 

 
 

Шаг 11 Завершить установку кнопкой Finish. 
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Шаг 12 Не запуская программу GreatCut, открыть файл .ecf, приложенный к письму 
с данными по лицензии. Необходимая информация будет автоматически 
добавлена в GreatCut, и ее не придется вносить повторно. 

 

 
 
 

Шаг 13 Если лицензию установить не удалось, поля заполняют вручную. Вся нужная 
информация находится в электронном сообщении. 
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Шаг 14 Программа GreatCut готова к работе. 
 

 

 
 

2.7.2 Установка ПО Sure Cuts A Lot (приобретается дополнительно) 
2.7.2.1 Автоматическая установка 

 

Шаг 1 Вставить установочный диск DVD в устройство чтения компакт-дисков. 
Программа совместима с Windows 7 и выше, Macintosh OSX 10.6 и выше. 

 

Шаг 2 Для запуска установки выбрать Sure Cuts A Lot. 
 

Шаг 3 Для продолжения нажать кнопку Next. 
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Шаг 4 Установить флажок I accept the agreement (Принимаю соглашение) 
и нажать Next. 

 

  
 
 

 
 

 

Шаг 5 Принять предложенную по умолчанию папку установки или выбрать другую 
папку для установки и нажать Next. 
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Шаг 6 Для создания значка программы на рабочем столе, установить флажок  

Create a desktop icon. Чтобы по умолчанию открывать файлы с расширением 
scut4 программой Sure Cuts A Lot, установить флажок Associated scut4 
extension. Запустить установку, нажав Next. 
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Шаг 7 Установить флажок Launch Sure Cuts A Lot (Запустить Sure Cuts A Lot) 
и завершить установку кнопкой Finish. 

 

 
 

Шаг 8 Запускается программа Sure Cuts A Lot. 
 

 
 
 

Шаг 9 Для активации программы Sure Cuts A Lot нажать Activate… Предварительно 
следует убедиться в наличии доступа к Интернету. 
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Шаг 10 Указать имя в графе Name и ввести в поле Serial (Серийный номер) код 
из 25 символов, указанный на обложке диска DVD. Завершить активацию 
кнопкой OK. 

  
 

Шаг 11 Запустить Sure Cuts A Lot, в меню Cutter выбрать My Cutter, затем Manage 
Cutters. 

 
 

Шаг 12 В списке компаний и марок выбрать GCC и нужную модель, нажать кнопку  
Add to list, затем Done. 
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Примечание Если для вывода изображений используется пробная версия 
(не введен ключ для активации программы Sure Cuts A Lot, как описано выше), 
плоттер прорежет на материале две лишние линии. До отправки файлов на резку 
необходимо убедиться, что лицензия Sure Cuts A Lot активирована. 

 

 

2.7.2.2. Активация программного обеспечения вручную 
 

Если на компьютере, подключенном к плоттеру, отсутствует доступ к Интернету, 
для завершения активации и работы с программой можно выбрать Activate manually 
и ввести код активации. Для этого следует найти компьютер с доступом к Интернету 
и заранее получить код активации, следуя инструкции ниже. 

 

Шаг 1 Установить флажок Activate manually, чтобы вывести на экран поля Site Code 
(Код сайта) и Activation Code (Код активации). В поле Site Code уже есть 
данные, которые нельзя изменить. 
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Шаг 2 На компьютере с доступом к Интернету открыть веб-страницу 
http://www.craftedge.com/activation/surecutsalot. Ввести имя, серийный номер 
(ключ программного обеспечения с обложки диска DVD) и код сайта (Site 
Code). 

 

Шаг 3 По щелчку на кнопке Generate Activation Code (Генерировать код активации) 
в поле Activation Code появится код активации. 

  

http://www.craftedge.com/activation/surecutsalot
http://www.craftedge.com/activation/surecutsalot
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Шаг 4 Код активации необходимо скопировать и вставить в диалоговое окно 

активации Sure Cuts A Lot, затем подтвердить кнопкой ОК. 

 
2.7.2.3 Повторная установка ПО Sure Cuts A Lot 

 
В случае замены компьютера может потребоваться деактивация программы Sure 
Cuts A Lot с повторной установкой на новом устройстве. 

 
Для этого выполнить Deactivate… из меню Help и подтвердить действие кнопкой Yes. 
Затем программу устанавливают на новом компьютере и активируют с помощью того 
же кода. 
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2.8 Настольная опора для гибких материалов (плоттер 
без автоподатчика) 

 
Руководство по установке настольной опоры для гибких материалов используется 
только для плоттера, без присоединения автоподатчика. 

 

Шаг 1 4 пластмассовые ножки поместить под опоры для рулонов. Вставить винты M4 
в отверстия в пластмассовой ножке и затянуть ключом под внутренний 
шестигранник для винтов M4 (рис. 2-13). 

 
Шаг 2 Совместить опорный кронштейн с опорой держателя рулона, вставить винты 

М6 в резьбовые отверстия опоры и затянуть ключом под внутренний 
шестигранник для винтов M6. (См. рис. 2-14). 

 

Шаг 3 Повернуть устройство нижней панелью набок и совместить опору 
держателей рулона в сборе с нижней панелью устройства. Пропустить 
винты M6 сквозь отверстия в опоре держателей рулонов, вставить 
в резьбовые отверстия в нижней панели устройства и затянуть ключом под 
внутренний шестигранник, как на рис. 2-15. 

 

 
 

Винты M6 

Отверстия 
  Рис. 2-16 

Держатель рулона 
в сборе 

 
  Держатели 
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Шаг 4 Установить два держателя рулонов шипами вала в пазы в опоре держателей  
(рис. 2-16). 

 

Шаг 5 Настольная подставка для материалов в сборе с плоттером показана 
на рис. 2-17. 

 

 
 
 
 

2.9 Использование демпферного валика (плоттер без автоподатчика) 
 

Регулировка демпфирования осуществляется вращением диска, как показано 
ниже. Чем больше число, тем сильнее демпфирующее усилие. Уровень 
демпфирования показан на наклейке с условным обозначением уровня  
(рис. 2-18, 19). 

 

             Рис. 2-18 

 
Рис. 2-19 

Рис. 2-17 
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2.8 Замена отрезного ножа 

 
Шаг 1 Отвинтить крышку с каретки с помощью отвертки (рис. 2-31 и 2-32). 
 

   
Рис. 2-31 Рис. 2-32 

 

Шаг 2 Снять крышку, которая теперь держится на каретке только на проводах 
(рис. 2-33 и 2-34). 

 

 
 

Рис. 2-33 



57 

AFR-24S. Руководство 
 

 

 
 

Шаг 3 Снять крышку полностью, отсоединив черный и красный провода между 
крышкой и кареткой от соединительной муфты (рис. 2-35 и 2-36). 

 
 

Примечание При отсоединении проводов от белой муфты соблюдать 
осторожность, чтобы не нарушить работу вентиляторов. 

 

 
Рис. 2-35 Рис. 2-36 

 
 

Шаг 4 Снять винт с левой части блока отреза (рис. 2-37 и 2-38). 
 

 
Рис. 2-37 Рис. 2-38 

Фиксатор ножа 

Винт 

Муфта 
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Шаг 5 Демонтировать весь блок отреза, удерживая его и одновременно смещая 
влево небольшую металлическую пластику справа налево (рис. 2-39 и 2-40). 

 
 

Рис. 2-39 Рис. 2-40 

 
Если толкнуть пластину влево, блок отреза отделится автоматически (рис. 2-41). 

 
 
 
 
 

Рис. 2-41 
 
 
 
 
 
 
 

Шаг 6 Снять винт блока отреза (рис. 2-42 и 2-43) и демонтировать фиксатор ножа 
отреза, потянув его вверх (рис. 2-44). 

 
 
 
 
 
 
 
 
 
 
 

Рис. 2-42 

Толкнуть влево 

Металлическ
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Рис. 2-43 
 

 
 
 
 
 
 
 
 
 
 
 

Рис. 2-44 
 
 
 
 
 
 
 
 
 
 

Шаг 7 Отвинтить нож от фиксатора, на котором он держится с помощью магнита. 
С помощью пинцета установить новый нож вдоль паза, отмеченного красным 
цветом (рис. 2-45 и 2-46). 

 

Примечание Отрезной нож очень острый. Обращаться осторожно. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Новый нож 
 
 
 
 

Рис. 2-45 Рис. 2-46 

Винт 

Отрезной нож 

Магнит 



60 

AFR-24S. Руководство 
 

 

 
Шаг 8 Присоединить фиксатор отрезного ножа к блоку отреза, толкнув держатель 

вверх (рис. 2-47 и 2-48), закрепить винтом (рис. 2-49). 
 
 
 
 
 
 

Рис. 2-47 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 2-48 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 2-49 
 
 
 
 
 

Шаг 9 Присоединить фиксатор отрезного ножа к каретке, нажимая на металлическую 
пластину справа и одновременно толкая блок отреза вверх (рис. 2-50 и 2-51). 
Прикрутить винт (рис. 2-52). 
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Рис. 2-50 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 2-51 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 2-52 

Толкнуть влево 
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Шаг 10 Снова подсоединить провода через белую соединительную муфту (рис. 2-53). 
 

       Рис. 2-53 

Шаг 11 Установить на место и закрепить крышку каретки. Для этого наживить 
и затянуть винт (рис. 2-54). 

 

  

Кончик винта 
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В этом разделе описаны функции кнопок и экранных меню плоттеров серии RX II.  
После подготовки плоттера к работе согласно разделам 1 и 2, для всех функций 
установлены параметры по умолчанию. 

 
3.1 Сенсорная панель 

 

 
<Сенсорная панель плоттера серии RX II> 

 
 

Элемент Функция 

ЖК-дисплей Для отображения функций и сообщений об ошибках. 

Светодиодный 
индикатор 

 

Для оповещения о состоянии (индикатор горит: питание 
включено; индикатор не горит: питание отключено) 

Клавиши-стрелки Для смены положения, выбора функции и изменения настроек. 

ENTER Для настройки и подтверждения значения, введенного 
последним. 

PAUSE/RESUME Для приостановки и возобновления резки 

ON/OFF LINE Для переключения режима, остановки резки, отмены изменений 
в параметрах. 

OFFSET Для регулировки смещения ножа. 

FORCE Для регулировки усилия реза. 

Глава 3  
 

Панель управления 
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SPEED Для регулировки скорости и качества реза. 

CUT TEST Для проверки реза на различных материалах. 

CUT OFF Для отрезания материала после завершения задания 

DATA CLEAR Для очистки буфера памяти. 

TOOL SELECT Для выбора инструментов. 

MISC Для настройки функций. 

 
 

Подробнее см. в «3.4. Пункты меню».



AFR-24S. Руководство 

64 

 

 

 

3.2 Меню в онлайн-режиме 
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3.3 Меню в автономном режиме 
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3.4 Пункты меню 
 
 

Меню/Кнопка Функция Параметр Исходн. 
--- Определение материала --- 

Roll Замер ширины материала Длина до 150 м  

Edge Замер ширины материала и протяжка материала 
назад до открытия фронтального датчика бумаги. Длина до 150 м 

 

Single Замер ширины и длины материала Длина до 10 м  

--- МОЩНОСТЬ --- 
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 Оповещение о состоянии.   

[ Кнопки со стрелками ] 
 1. Перемещение каретки с инструментом по оси X или Y. 

2. Выбор функций и изменение значений параметров. 
  

[ ENTER ] 
 1. Отображаемые параметры сохраняются 

автоматически. 
2. Задание текущего положения каретки в качестве 

исходной точки. 
В режиме offline передвинуть каретку в нужное 
положение [клавишами со стрелками], после чего 
клавишей ENTER задать новую исходную точку. При 
перемещении с отображением параметров по осям XY 
нажать клавишу [MISC] для точного перемещения. Для 
отключения функции снова нажать [MISC]. 

  

[ PAUSE/RESUME ] 
 Приостановка процесса резки. 

Чтобы возобновить резку, нажать [Pause/Resume] 
повторно. 

  

[ ONLINE/OFFLINE ] 
 1. Переключение между активным и автономным 

режимами. 
2. Остановка резки или сброс изменений в параметрах. 

При нажатии клавиши задание реза немедленно 
прерывается и не может быть возобновлено. 

  

[ OFFSET ] 
 Задание или изменение расстояния между острием ножа 

и центральной осью. 
от 0,000 до 
1000 мм 

0,275 мм 

[ FORCE ] 
C Force Настройка или изменение усилия режущего ножа. 

Если усилие реза превышает 450 г, скорость реза не 
должна быть выше 15 см/с в режиме Small Letter. При 
усилии реза 300–449 г скорость реза должна составлять 
не более 30 см/с в режиме Fine. 

от 5 до 600 г 
шаг 5 г 

80 г 

P Force Настройка или изменение усилия пера. 
Если усилие пера превышает 450 г, скорость пера не 
должна быть выше 15 см/с в режиме Small Letter. При 
усилии реза 300–449 г скорость пера должна составлять 
не более 30 см/с в режиме Fine. 

от 5 до 600 г 
шаг 5 г 

80 г 

[ SPEED ] 

 С Speed Настройка или изменение скорости перемещения ножа 
по горизонтали. Если скорость реза превышает 72 см/с, 
качество реза устанавливают на Normal. 

от 3 до 153 
см/с; шаг 3 

72 см/с 

 P Speed Настройка или изменение скорости перемещения пера 
по горизонтали. 

от 3 до 153 
см/с; шаг 3 

72 см/с 

Up Speed: Задание или изменение скорости перемещения 
инструмента от конечной точки до следующей 
начальной точки по горизонтали. 

от 3 до 153 
см/с; шаг 3 

72 см/с 

AAS Speed Настройка и изменение скорости распознавания AAS. High, Medium, 
Low 

Medium 
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C Quality Настройка или изменение качества резки (ускорения). 
Draft (4.2G), Fair (2.8G), Normal (1.4G), Fine 
(0.7G), Small Letter (0.2G). 
Для мелких букв установить значение Small letter. 
Для большой скорости установить значение Draft.  
В обычном режиме установить значение Normal. 
 

Draft, Fair, 
Normal, Fine, 
Small Letter 

Normal 

P Quality Настройка или изменение качества графопостроения 
(ускорения). Draft (4.2G), Fair (2.8G), Normal (1.4G), Fine 
(0.7G), Small Letter (0.2G). 
Для мелких букв установить значение Small letter. 
Для большой скорости установить значение Draft.  
В обычном режиме установить значение Normal. 
 

Draft, Fair, 
Normal, Fine, 
Small Letter 

Normal 

[ CUT TEST ] 

Square Cut Тестирование резки с текущим положением ножа. 
Подробнее о регулировке усилия ножа и скорости 
реза см. в разделе «4.3. Регулировка силы реза и 
смещения». 

  

Redo Jobs 
in Memory 

Для повторного выполнения сохраненного в памяти 
тестового задания: повторный рез или получение 
тестовых копий. Кол. повторов: 0 = бесконечно. Если 
значение нужно установить на 0, это делают между 
перезапуском плоттера и опусканием рычага. 

Recut (число 
повторов: 0-99) 

Copy (число 
заданий: 1-999) 

Recut 

Repeat AAS 
Job 

Для автоматического повторения задания из AAS без 
отправки с компьютера. 
Внимание: функция обычно применяется для режима 
бумаги Single. Перед запуском убедиться, что 
загружен новый материал и в качестве исходной 
точки задана первая приводочная метка. По 
окончании задания AAS пользователю будет 
предложено на выбор повторить задание (Repeat 
AAS Job Again) или вернуться в главное меню, нажав 
Online/Offline. 
Сообщение выводится по окончании считывания всех 
приводочных меток  

  

Blade 
Length 
Adjust 

Подробнее см. «2.5. Автоматическое 
определение высоты ножа». Регулировка длины 
выступающей части ножа Примечание: 
1. До начала регулировки высота ножа должна 

составлять 0. 
2. Сначала проверяется держатель ножа, затем 

нажатием клавиши ENTER запускается 
тестирование высоты ножа. 

3. При проверке держателя ножа и высоты 
выступающей части держатель должен 
оставаться в одном положении. 

4. По завершении проверки на экране будет показано, 
на сколько (величина после обозначения CW или 
CCW) и в каком направлении [CW (по часовой 
стрелке) или CCW (против часовой стрелки)] 
повернуть регулировочную головку. 
Например, Turn CW 5 означает «повернуть ручку на 
5 делений по часовой стрелке». 

Если значение на экране 0.0, высота ножа оптимальна 
и не требует корректировки. Можно приступить к резке. 

От 0,00 до 5,00 мм 0.00mm 
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Pattern Setting Два режима тестового реза 
Примечание. Для материалов большой толщины 
рекомендована опция Cross. 

Шаблоны Arrow 
(стрелка) и Cross 
(крест). 

Arrow 
 

Ratio Setting Для настройки размеров элемента 100%, 200%, 
300%, 400% 

100% 

 
[ DATA CLEAR ] 

 Для очистки буфера памяти.   

[ TOOL SELECT ] 
Save 
Parameter 

Сохранение параметра (-ов) резки для дальнейшего 
использования. На панели сохраняются 4 набора 
параметров. Клавишами Page Up и Page Down выбрать 
нужный набор параметров, нажать Enter для (число 
в левом верхнем углу при этом изменится). В набор 
параметров входят: Speed (скорость), Force (сила), Offset 
(смещение), Up Speed (скорость по вертикали), Quality 
(качество), Scaling (масштаб). Три последних в этом 
разделе не отображаются. Для корректировки или 
проверки отдельных значений вернуться с помощью 
соответствующих клавиш панели и нажать Enter для 
подтверждения. 

Схема 1: винил 
 
Схема 2: 
тонирование 
витрин 
 
Схемы 3 и 4: 
значение по 
умолчанию, 
которое можно 
изменить 

Схемы 3 
и 4 

Set Smoothing 
Cut 

Включение функции плавной резки.  Enable 

Over Cut Резка с нахлестом для удобного отделения облоя. 0,00 до 1,00 мм 
с шагом 0,05 мм 

0.00mm 

Set Tangential 
Mode 

Эмуляция тангенциального режима для толстых 
материалов и мелких букв. Примечание: при значении 
Offset, установленном на 0,000 мм, меню Set Tangential 
Mode будет недоступно. 

 Enable 

Pouncing Получение перфорированных контуров. 
* Для использования функции необходим  
  перфорирующий инструмент. 
* Перед запуском перфорации защитить марзан, 

положив на него специальную ленту. 
* Для отключения режима значение устанавливают на 0. 
* Инструмент для перфорации приобретается 

дополнительно. 

от 0 до 200 мм 0mm 

Настройка 
панели 

Accept setup command: 
Ввод команд Force, Speed, Cutting Quality и Offset 
только из программы. 

 Accept 
setup 
command 

 Control panel only: 
Ввод команд Force, Speed, Cutting Quality и Offset 
только с панели управления плоттера. 

  

Factory Default Сброс всех параметров меню до заводских настроек.   

[ MISC ] 
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Auto Unrolled 
Media 

Предотвращение затора бумаги и отказа двигателя 
путем автоматической размотки материала (50 см и 
более) перед началом резки.  
* Автоматическая размотка действует только с рулонами. 
* При переходе в режим Single функция автоматически 
отключается. 

* Если в рулоне меньше 2 м материала или он мало 
весит, функцию рекомендуется отключить. 

 Enable 

Auto Unrolled 
Length 

Регулировкп длины размотанного материала. от 500 до 
3000 мм 

3000 мм 

Auto Unrolled 
Media 

Регулировка скорости размотанного материала. Slow, 
Normal, Fast 

Normal 

Adjust Paper Для указания положения, из которого самонаклад 
будет подавать лист из стопы в рабочую область. 
Чем выше значение Adjust paper, тем больше 
расстояние подачи листа из стопы. 

Настройка 
действительна 
с автоподатчиком и 
при автономной 
работе плоттера.(* Для 
Jaguar-61 и RXII-61-
Creasing автоподачик 
— опция). 

-40.0 – 
40.0mm, 
0.5mm /per 
step OFF 

29.0mm 

Rear 
Paper 
Sensor 

Определение доступности бокового датчика бумаги. 
Если режим активирован, плоттер распознает, 
перекрыл ли материал боковой датчик бумаги 
в режимах Roll и Edge. При отключении боковой датчик 
работать не будет. 
Примечание Боковой датчик бумаги функционирует 
только в режимах Roll и Edge. 

Enable 
Disable 

Enable 

AAS 
Detect 
Mode 

Для определения направления загрузки материала. 
1. Forward direction: для распознавания меток при 

стандартной подаче материала.  
2. Auto detection: направление загрузки материала 

распознается автоматически. 
3. Reverse direction: при подаче материала 

в перевернутом положении.  
 

Auto detection, 
reverse 
direction, 
forward 
direction 

Auto 
detection 

Sizing Setting Для настройки размеров материала. 
При режиме User Defined пользователь задает размер 
при каждом включении устройства. 
В режимах Default Edge or Roll, после включения 
устройства будет определяться положение кромки или 
рулона. 

USER 
Defined, 
Default 
EDGE, 
Default 
ROLL 

User 
Defined 

Vacuum Включение вентиляторов для оптимизации отслеживания 
и точности реза. При отключении вакуума вентиляторы 
будут бездействовать в режиме резки и графопостроения. 

Enable  
Disable 

Enable 
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First Back to 
Origin 

Возвращение каретки в предыдущую исходную точку. 
При выборе Enable каретка не вернется в предыдущую 
точку. При выборе Disable каретка вернется 
в предыдущую точку. 

Enable 
Disable 

Enable 

AAS Copy Подключение копирования AAS. При выборе Enable 
модуль AAS продолжит считывание приводочных меток 
для контурной резки. Пользователь может задать 
расстояние между изображениями и количество копий 
AAS. Диапазон расстояний от 0 до 500 мм, количество 
копий от 0 до 1000. 

Enable 
Disable 

Enable 

AAS Offset Для настройки и изменения смещения AAS. 
Подробнее см. «5.3. Тестирование принтера». 

  

Paper 
Saving 
Mode 

Четыре режима экономии материала: 
1. Увеличение длины 2. Увеличение ширины 
3. Увеличение длины и ширины 4. Без увеличения 

 Length 
expanded 
mode 

Pen_Blade 
Offset 

Коррекция расстояния между пером и резаком 
на каретке. 
1. Клавишами со стрелками передвинуть к курсор 
в нужное положение для графопостроения. Для 
завершения настройки и перехода к следующему шагу. 
2. Если линии построения и реза не одинаковы, значения 
X и Y для параметра Pen overlap Cut корректируют по 
таблице ниже. 
Переключение между осями X и Y клавишами ← и → . 

Черная линия: перо, красная линия: линия реза. 

  

Scale Length Фиксированный масштаб, только для технического 
обслуживания. 

  

Scale Width 

DHCP Ваш IP-адрес для конфигурации TCP/IP  Disable 

IP Address IP Address IP-адрес режущего плоттера.   

MAC Address MAC-адрес режущего плоттера.   

Select 
Language 

Выбор языка панели: английский, испанский, 
итальянский, немецкий, португальский, польский, 
турецкий, французский. 

 English 
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Select Units Система измерения для удобства пользователя. cm/s; inch/oz; 
cm/oz; 
inch/gram 

метрич. 

Firmware 
Version 

Версия встроенного программного обеспечения и код 
FPGA. 

  

Set 
Communication 

Настройка обмена данными между компьютером 
и плоттером. 
Baud Rate определяет скорость передачи данных. 
Data Bits определяет размер одного блока данных. 
Parity контроль корректности передачи данных.  
9600, n, 7, 1, p  9600 бит/с, 7 бит, БЕЗ контроля 
9600, n, 7, 1, p  9600 бит/с, 7 бит, НЕЧЕТНОСТЬ 
9600, n, 7, 1, p  9600 бит/с, 7 бит, ЧЕТНОСТЬ 
9600, n, 8, 1, p  9600 бит/с, 8 бит, БЕЗ контроля 
9600, n, 8, 1, p  9600 бит/с, 8 бит, НЕЧЕТНОСТЬ 
9600, n, 8, 1, p  9600 бит/с, 8 бит, ЧЕТНОСТЬ 
19200, n, 7, 1, p  19200 бит/с, 7 бит, БЕЗ контроля 
19200, n, 7, 1, p  19200 бит/с, 7 бит, НЕЧЕТНОСТЬ 
19200, n, 7, 1, p  19200 бит/с, 7 бит, ЧЕТНОСТЬ 
19200, n, 8, 1, p  19200 бит/с, 8 бит, БЕЗ контроля 
19200, n, 8, 1, p  19200 бит/с, 8 бит, НЕЧЕТНОСТЬ 
19200, n, 8, 1, p  19200 бит/с, 8 бит, ЧЕТНОСТЬ 

  

Image Scale 
Length 

Регулировка масштаба изображения по отношению 
к длине и ширине материала с учетом толщины 
материала. 

 

Числитель — идеальная длина, знаменатель — 
реальная длина по факту. 

 

Пример: резка линии длиной 500,0 мм. Процедура: 
1. Нажатием [СТРЕЛКИ ВЛЕВО] выбрать числитель и 

500.0 mm. 
2. Отправить графический файл для резки 
3. Измерить длину, затем [СТРЕЛКОЙ ВПРАВО] 

выбрать знаменатель, 
4. Нажатием [СТРЕЛКИ ВВЕРХ / СТРЕЛКИ ВНИЗ] 

изменить значение фактической длины 

 500/500 мм 

Image Scale 
Width 

Section Cut При секционной резке длинный макет делится на части, 
что повышает качество и точность обработки. 
Сегменты можно настроить по приводочным меткам 
или ввести значения вручную. 

 интервалы 
по 200 мм 

Pen Height 
Detect 

Автоматическое определение высоты пера   

[ CUT OFF ] 
Cut off Paper Для автоматического отреза материала по завершении 

задания клавишами со стрелками подвести каретку 
к нужной точке для отреза материала вручную и нажать 
кнопку CUT OFF. 
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4.1 Загрузка листов в автоподатчик 
 
Шаг 1 Отрегулировать положение прижимного ролика под нужный формат материала. 
 

 
 

 

 
Шаг 22 Подпереть кромки листов Г-образными упорами. 

 

  
  

ПРИМЕЧАНИЕ В автоподатчике использовать только материалы 
с покрытием. В противном случае чашечная присоска 
не сможет их удержать из-за утечки воздуха. 

Глава 4  
 

Эксплуатация 
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Шаг 3 Подключить автоподатчик к плоттеру с помощью кабеля RS232. 
 

 
 

Шаг 4 Включить кабель электропитания в розетку и включить питание. 
 

          
 

Шаг 5 Включить режущий плоттер. 
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Шаг 6 Опустив рычаг, поднять прижимной ролик. 
 
 

 
 
 

Шаг 7 Нажать клавишу ENTER для определения ширины материала. 
 

 
 
 

Шаг 8 В меню MISC с помощью левой и правой стрелок выбрать Adjust Paper 
и нажать ENTER. Установить для параметра Adjust Paper (Регулировка 
бумаги) значение 22,5 мм и подтвердить клавишей ENTER. 

 

  
 

Adjust Paper  22.5 mm  

Select:     OK: ENTER 

Offline For System Setup 

[MISC] 
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передней кромки материала после определения 
размера. 
 
Чем выше значение Adjust paper, тем ближе 
передняя кромка материала к ножу. 
 

Примечание Команда Adjust paper служит для настройки положения 
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Шаг 9 С помощью левой и правой стрелок выбрать AAS copy (Подключение 
копирования AAS). 

 

 
 
 

Шаг 10 Стрелками вверх и вниз указать повторяемое значение (от 0 до 500). 
 

 
 
 

Шаг 11  Отправить задание с компьютера. Режущий плоттер с податчиком начнет 
автоматизированный процесс резки. 

 
 

 



79 

AFR-24S. Руководство 

 

 

 
 

4.1.1 Работа в автоматическом режиме 
 

1. Возьмите материал из лотка для загрузки в плоттер 
 

 
 
 

ПРИМЕЧАНИЕ 

Вентиляторы по обе стороны лотка автоматически включаются для отделения 
материала, когда тот готов к подаче. Контроль объема воздуха с учетом типа 
материала производится отключением вентиляторов. 

 

 
 
 

2. После определения размеров материала плоттер AAS II распознает 
приводочные метки. 
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3. Начать биговку 
ПРИМЕЧАНИЕ Доступно только при настройке функции биговки через ПО 
(см. 4.6.2 Настройка драйвера печати RX II-Creasing > Вкладка Creasing) 

 

 
 
 

4. После завершения биговки начинается резка. 

ПРИМЕЧАНИЕ Для повышения качества обработки бумажных коробок вместо 
обычной резки рекомендуется выбирать высечку или надсечку. 

 
 
 

5. Готовое задание поступает в лоток для приема материала. 
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4.2 Как загрузить листы в плоттер без автоподатчика 
 

Для правильной загрузки материала выполнить перечисленные ниже шаги. 
 
Шаг 1 
Рычагом с верхней правой стороны режущего плоттера поднять или опустить 
нижние прижимные ролики. Потянуть рычаг вперед до щелчка, чтобы поднять 
ролики (рис. 4-1). 
 
 
 

 
 
 

 
 
 

 
Рис. 4-1 

 
 

Шаг 2  
Положить материал на опорную пластину и протолкнуть его под прижимные ролики 
спереди или сзади. Для выравнивания материала на опорной пластине имеются 
приводочные линейки. 
 

  
 
 

Датчики 
 

Рис. 4-2 

Примечание 
При загрузке материала 
убедиться, что он перекрыл 
датчики бумаги на опорной 
пластине. Должны быть 
перекрыты как минимум два 
датчика бумаги (рис. 4-2).  
Как только материал перекроет 
датчики, режущий плоттер 
автоматически определит 
длину и ширину материала. 

Рычаг 
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Шаг 33  
Вручную переместить прижимные ролики в нужное положение. Прижимные ролики 
должны находиться на решетчатом барабане. Определить положение барабанов 
можно по белым меткам на верхней станине. После этого отвести рычаг назад, 
чтобы опустить прижимные ролики. 
 

 
 
 
 
 
 
 
 
 

Рис. 4-3 
 
 
 
 

 
 

Шаг 4 
Поместить материал так, чтобы он помещался в рабочий диапазон. 

 

  
 
 

Шаг 5 
Отвести рычаг назад, чтобы опустить прижимные ролики. 

 
 

Шаг 6 
Включить питание. Каретка инструмента автоматически определит размер материала. 
Режущий плоттер начнет работать. 

Белые метки 
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u 

 

 
 

 
 

(X) 
Неправильно 

 
 
 
 
 
 

 
 
 
 

 
 

 
 
 

Рис. 4-5 
 
 
 

ВКЛЮЧИТЬ 

 
 
 
 
 
 
 

Нажать снизу, чтобы освободить захват 

Примечание 
Для правильного определения ширины материала сначала поднимают все 
прижимные ролики (рис. 4-5) и только потом толкают рычаг. 

Примечание 
1. Регулировку положения проводить только с поднятым прижимным роликом. 
2. Для перемещения прижимного ролика нажать на торец опоры ролика. 
3. Не перемещать ролик за переднюю прорезиненную часть (рис. 4-4). 
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4.3 Усилие реза и регулировка смещения 
 

Чтобы получить хорошие результаты резки, до отправки дизайна на плоттер можно 
провести тестирование. Функцию Cut Test повторяют до получения нужного 
результата на материале. 
После измерения материала нажать кнопку [CUT TEST], выбрать square cut 
и подтвердить клавишей [ENTER]. 

 
 
 
 
 
 
 

1 

 
 
Усилие реза и величина смещения по умолчанию составляют 80 г и 0,275 мм, 
соответственно. Клавишами со стрелками переместить каретку в нужную позицию. 
Клавишей [ENTER] запустить тестовый рез. 
 
Примечание. При тестовом резе одновременно задается новая исходная точка. 
 
Плоттер вырежет нужный макет. Следует проверить, насколько легко облой 
отделяется от материала. Если легко, усилие реза выбрано верно. Если облой 
не отделяется или прорезан, клавишей [FORCE] отрегулировать усилие инструмента 
до получения нужного результата (рис. 4-14). 

  

2 
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Если получен результат типа BB или CC, следует регулировать смещение клавишей 
[OFFSET] до получения результата AA. 

 
 

Рис. 4-14
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4.3 Как вырезать буквы в 3 мм 
 

Для получения качественного результата рекомендуется брать узкие материалы.  
При работе с широкими материалами: 

 
1. Расположить два прижимных ролика как можно ближе с двух 

сторон области реза. 
2. Убедиться, что материал выровнен, натяжение равномерное 

по всей ширине опорной пластины. 
3. Рекомендованные настройки: 

Усилие реза: 55 г (или в зависимости от материала)  
Скорость реза: 45–50 см/с 
Скорость инструмента: 45–60 см/с  
Плавный рез: Disable 
Quality: Small Letter 

 
 
 

4.4 Как закончить резку 
 

Закончив работу, поднять рычаг для загрузки листов и вынуть материал или 
активировать функцию отреза. 

 
Отрезать материал вручную 
Отрезать готовую продукцию удобно с помощью безопасного ножа (входит 
в комплект) вдоль направляющей (рис. 4-17). 

 
Отрезать материал автоматически 
Чтобы использовать встроенный отрезной нож, подвести каретку к нужной точке, 
задать расстояние между отрезаемым изображением и линией отреза и нажать 
кнопку CUT OFF на панели управления. Материал будет отрезан автоматически. 

 

 

 
 

Рис. 4-17 
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4.6 Настройка драйвера печати RX II-Creasing 

 
4.6.1 Настройка драйвера печати RX II-Creasing > Вкладка Option 
 

 
 
 
Настройка: перечисленные ниже параметры устанавливаются в зависимости 
от приложения и желаемых результатов. 

 
Quality 
[Ниже скорость / выше качество - Выше скорость / ниже качество] 
Параметр Cutting Quality задает соотношение качества и скорости в зависимости 
от конкретного задания. Режим Draft — самая высокая скорость в ущерб качеству. 
Режим Small letter — самое высокое качество в ущерб скорости. Необходимо 
учитывать, что скорость и качество — понятия взаимоисключающие. 
 
Blade 
Выберите тип ножа для конкретного задания. 
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Use Plotter Setting 
Параметры будут соответствовать введенным с панели управления. 

 
Back to home 
При установке флажка каретка будет возвращаться в исходную позицию. 
 
Auto Cutoff 
По окончании работы плоттер отрезает материал. Это упрощает эксплуатацию 
резака без оператора на больших объемах заказов. Материал будет отрезан 
автоматически при установке флажка Auto Cut в драйвере GCC. Здесь же 
настраивается расстояние между отрезаемым изображением и линией отреза. 

 
Значение по умолчанию — 10 мм: материал отрезается на расстоянии 10 мм 
от изображения. Значение функции отреза регулируется в диапазоне от 0 до 100 мм, 
в зависимости от задачи. 

 
Векторная функция 

 
1. Normal 
Значение для векторной функции по умолчанию. Порядок резки зависит от порядка 
создания графики в программном приложении. 

 
2. X sorting 
Порядок резки определяется следующим ближайшим объектов по оси X 
от исходной точки. В примере ниже порядок резки будем следующим: 1, 2, 3, 4 
(см. рис. 4-19). 

 
 
 
 
 
 
 
 
 

Рис. 4-19 
 
 
 

3. Inside Out Cutting 
При резке векторного макета, где у изображения есть зона резки, 
соприкасающаяся с другой зоной резки, выбирается режим Inside-out Sorting 
(сортировать изнутри наружу). В этом режиме драйвер печати автоматически 

 
 

 

 
4 

2 

3 
 
1 
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обрабатывает внутреннее векторное изображение, затем переходит к наружному. 
Таким образом, режущий плоттер автоматически начинает с внутреннего 
векторного изображения, постепенно перемещаясь наружу. 

 
4. Cutting Path Optimization 
Настройка, уменьшающая время обработки. При установке флажка драйвер 
принтера анализирует изображение и автоматически определяет самую 
эффективную траекторию его обработки. 
 
5. Section Cutting 
Пользователи могут выводить длинные макеты посегментно. Результат будет 
стабильнее, а качество печати — выше. Сегменты можно настроить 
по приводочным меткам или ввести значения вручную. Закончив резку первого 
сегмента, плоттер перейдет ко второму. См. рис. ниже: 
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File Function (вкладка Option) 
Раздел для управления параметрами режущего плоттера. При повторяющихся 
работах это позволяет сохранить самые распространенные настройки и загружать их 
по мере необходимости. 

 
 

• Custom Media. Раздел содержит список недавно созданных и использованных 
файлов с параметрами настройки. Для удобства работы можно сохранять более 
50 файлов. 

 
 

• Default. В разделе содержатся эталонные настройки для проверенных материалов, 
обеспечивающие наилучшие результаты резки. Рекомендованные параметры могут 
нуждаться в корректировке в зависимости от поставщика материалов. 

 
 

• SAVE. Сохраняет текущие настройки драйвера печати в файл в указанной папке 
компьютера. (Сохраненные файлы с параметрами помечаются расширением серии 
RX II) 

 
 

• LOAD. Загружает ранее сохраненные параметры драйвера печати. 
 
 

• ORIGINAL. Загружает исходные заводские параметры драйвера печати. 
 
 

• SAVE TO DEFAULT. Сохраняет текущие параметры драйвера печати как исходные 
параметры по умолчанию. 

 
 

• DELETE. Удаляет выбранный файл из раздела Custom Media. Настройки в разделе 
Default удалить невозможно. Внимание: функция удаляет только список, 
показанный в разделе Custom Media, не затрагивая файл .RX на жестком диске. 
Удалить файл с жесткого диска можно только вручную через операционную 
систему. 

 
 
 

 

Примечание 
При работе с операционной системой Windows 2000 или XP для 
сохранения настроек режущего плоттера необходимо войти в систему 
с учетой записи администратора или с правами администратора. 
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4.6.2 Настройка драйвера печати RX II-Creasing > Вкладка Creasing 
 

В серии RX II 16 различных параметров реза, включая скорость реза и смещение 
ножа, представлены 16-ю различными цветами. Эти цвета называют 
«инструментами» (Tools). Каждый цвет соответствует определенному параметру 
плоттера. Изображение, состоящее из черного, красного и синего цветов, будет 
обработано с настройками, присвоенными каждому из этих цветов. Чтобы 
использовать до 16 разных цветов (параметров режущего плоттера), необходимо, 
чтобы графическая программа распознавала и использовала 16 цветов, присвоенных 
драйвером печати GCC RX II (см. рис. 4-21). 
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Рис. 4-21 
 

Чтобы назначить собственные цвета для определенного параметра плоттера, 
достаточно дважды щелкнуть на нужном цвете в меню биговки. В окне менеджера 
цветов нажать «Define custom colors» и выбрать собственные цвета (см. рисунок 
ниже). Это удобно, если изображение состоит из цветов, которые не входят в меню 
биговки по умолчанию. В этом случае вместо внесения изменений в макет достаточно 
присвоить параметры, соответствующие цветам изображения. 

 
 

 
 

Необходимо, чтобы цветовой код RGB в графическом редакторе, например, 
CorelDRAW или Adobe Illustrator, был тот же, что на вкладке Creasing (Биговка) в окне 
драйвера печати. Это обеспечит правильные параметры обработки плоттером. 
Выполнить пошаговые инструкции ниже. 

Примечание 
Драйвер устройств серии GCC RX II хранит не более 16 цветов или 
различных параметров настройки в одном файле. 
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1. Дважды щелкнуть на задаваемом цвете и нажать кнопку Define Custom 
Colors (Задать пользовательские цвета). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 4-22 
 
 
 
 
 
 
 
 
 
 

2. Запомнить код RGB. 
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3. Открыть Outline Pen Color (Цвет контура пера). В программе CorelDRAW 
нажать More… и выбрать RBG или активировать инструмент Color Picker 
(Пипетка) в Adobe Illustrator. 

 
 

  

CorelDRAW 
 
 
 
 

 

Adobe Illustrator 
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4. Убедиться, что код в CorelDRAW или Adobe Illustrator тот же, что 
в драйвере печати — для правильных параметров плоттера. 

 

 
CorelDRAW 

 

 
Adobe Illustrator 
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Speed (Скорость) на вкладке Creasing [ЗНАЧЕНИЕ ПО УМОЛЧАНИЮ: 72 см/с] 
Ползунок скорости регулирует скорость реза в процессе работы плоттера 
в диапазоне от 3 до 153 см/с. Максимальная скорость реза для серии GCC RX II 
составляет 153 см/с. 

 
 

Force (Усилие реза) на вкладке Creasing [ЗНАЧЕНИЕ ПО УМОЛЧАНИЮ: 80 гс] 
Ползунок регулирует усилие реза в процессе работы плоттера в диапазоне от 0 
до 600 гс. 

 
 

Offset (Смещение) на вкладке Creasing [ЗНАЧЕНИЕ ПО УМОЛЧАНИЮ: 0,25 мм] 
Ползунок регулирует смещение ножа с учетом выбранного типа ножа. 

 
 

Die Cut (Высечка) на вкладке Creasing 
Функция Die cut позволяет прорезать материал вместе с подложкой. Для этой 
функции доступны только первые 8 цветов. Если выбрать цвет №1 и нажать Die Cut, 
цвет №9 станет цветом №1* для настройки другого параметра для той же линии реза 
(рис. 4-24). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Рис. 4-24 
 
 
 

Рис. 4-23 
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При необходимости любой параметр, включая силу и длину, можно откорректировать для 
маркера №1 и маркера №1*. 

 
Пример: 

 

 
 
 
 
 
 
Рис. 4-26 

Наклейка 
 
 
 

 
 
 
 
 
 
 
 

Image Scaling (Масштабирование изображения) на вкладке Creasing 
 

Функция позволяет настроить масштаб изображения относительно длины и ширины 
материала, чтобы сократить разницу между фактической и оптимальной длиной из-за 
различия в материалах, которые используются для резки. 

 
 
 
 
 
 

 
 
 

Цвет №1: прорезается только винил 
 

Цвет №1*: прорезается подложка материала 
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4.6.3 Настройка драйвера печати RX II-Creasing > Вкладка Paper 
 
 

 
 
Paper Size (Формат бумаги) на вкладке Paper [ЗНАЧЕНИЕ ПО УМОЛЧАНИЮ: 
Y = ширина устройства; X рассчитывается автоматически умножением длины Y 
на два] 

 
Формат бумаги соответствует общей рабочей площади. Значение X соответствует 
длине, Y — ширине. Для лучшего качества реза формат бумаги должен 
соответствовать изображению. 

 
Unit (Единицы измерения) на вкладке Paper [ЗНАЧЕНИЕ ПО УМОЛЧАНИЮ: 
Metric (мм)] 
 
Для настройки стандартных единиц измерения, с которыми будет работать драйвер 
плоттера RX II, — метрических или дюймовых. 
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4.6.4 Настройка драйвера печати RX II-Creasing > Вкладка Paper Feeder 
 

 
 

Настройки на вкладке Paper Feeder действуют, если к файлу резки применяется 
настройка позиционирования приводочных меток по двум точкам. См. раздел A-4 
«Добавление меток приводки по двум точкам» или A-5 «Добавление меток приводки 
по двум точкам». 

• Repeat count: определение количества копий в одном задании на резку 
 

• P3 (X,Y) / P4 (X,Y): значение смещения по оси X и Y (горизонтальная линия — Y, 
вертикальная линия — X (лицом к режущему плоттеру). 

Если нужно сместить линию реза и отпечатанную линию по направлению к метке  P1, 
указывают отрицательное значение смещения. Если нужно сместить линию от метки 
P1, вводят положительное значение смещения. Это относится к осям X и Y. 
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4.8. Рекомендованные настройки для различных материалов 
 
Параметры ниже используются для материалов из таблицы, сертифицированных GCC. 

 
Материал Персон. и настенные 

 наклейки 
Наклейки на 
автомобили Витринный декор Тонирование витрин 

Нож красный красный красный красный / желтый 

Длина лезвия, мм 0,28 0,27 0,25 0,09 

Усилие, гс 105 85 95 70 

Скорость, см/с 72 60 65 72 

Смещение, мм 0,25 0,25 0,25 0,25 

Рекомендованная 
модель 

RX, Jaguar, Puma,EX  
AR 

RX, Jaguar, Puma, 
EX, AR 

RX, Jaguar, Puma, 
EX, AR 

RX, Jaguar, Puma, 
EX, AR 

Материал Трафарет Светоотражающая 
пленка Флок Картон  

Нож красный / зеленый зеленый зеленый зеленый  

Длина лезвия, мм 0,3 0,5 0,3 0,3 

Усилие, гс 180 380 135 165 

Скорость, см/с 15 3 30 30 

Смещение, мм 0,25 / 0,5 0,5 0,5 0,5 

Рекомендованная 
модель 

RX, Jaguar, Puma, 
EX, AR 

RX, Jaguar, Puma, 
EX, AR 

RX, Jaguar, Puma, 
EX, AR 

RX, Jaguar, Puma, 
EX, AR 

Материал 
Магниты Тонировочная 

защита Стразы Маска для 
пескоструйки 

Нож зеленый зеленый зеленый синий 

Длина лезвия, мм 0,8 0,3 0,8 0,27 

Усилие, гс 580 320 190 85 

Скорость, см/с 3 3 15 60 

Смещение, мм 0,5 0,5 0,5 0,25 

Рекомендованная 
модель RX, Jaguar 

RX, Jaguar, Puma, 
EX RX, Jaguar, Puma 

RX, Jaguar, Puma, 
EX, AR 

Материал Мелкий текст 
(винил) 

Нож черный 

Длина лезвия, мм 0,27 

Усилие, гс толстый: 150 
тонкий: 90 

Скорость, см/с 9 

Смещение, мм 0,175 

Рекомендованная 
модель 

RX, Jaguar, Puma 
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Внимание! Этот раздел представляет собой вводную инструкцию к AASII. Пошаговые 
инструкции приведены в следующих разделах: A-4 модуль CorelDRAW, A-5 модуль 
Illustrator, A-6 модуль GreatCut. 

 

5.1 Общая информация 
Серия режущих плоттеров RX II укомплектована стандартной системой 
автоматического выравнивания (AAS II), которая распознает приводочные метки 
на отпечатках, гарантируя точность реза. 

 

Уведомление 
 
 �Избегать горизонтального освещения модуля AAS любым источником света. 

 
 
 
 
 
 
 
 
 
 

- - ЗАПРЕЩАЕТСЯ - РАЗРЕШЕНО 
 
 

 ЗАПРЕЩАЕТСЯ снимать крышку модуля AAS в процессе работы. 

 
- ЗАПРЕЩАЕТСЯ 

Глава 5  
 

 Система автоматического выравнивания 
 



10
 

AFR-24S. Руководство 

 

 

 

5.2 Система контурной резки AAS 
 
Исключительная точность работы системы AAS обеспечивается специальными 
калибровочными процедурами. Для работы с системой AAS необходимо уметь 
загружать материал (См. 4.2 Как загрузить листы в плоттер на стр. 77) 

 

5.2.1 Примечание по приводочным меткам 
Первая приводочная метка должна отличаться, чтобы ее распознавала система AAS. 
На автоматическое считывание меток влияют следующие факторы. 

 Тип материала 

 Расположение приводочных меток 

 Диапазон считывания для распознавания приводочных меток 

 Положение приводочных меток и материал 

 

Приводочные метки должны быть: 
 Созданы в программе для резки типа GreatCut, SCAL, модуля Illistrator или 

CorelDRAW, SignPal. 

 Черного цвета (важно качество печати приводочных меток: неверные цвета, 
проблемы приводки, размытие, размазывание могут ухудшить результаты резки) 

 
 

 Длина Толщина Поля 

Диапазон от 5 до 50 мм от 1 до 2 мм от 0 до 50 мм 

Оптимально 25 мм 1 мм 5 мм 

 
 

Режущий плоттер не распознает метки, если: 
 Перед распознаванием каретку плоттера не подвели к внешней границе 

первой метки. 
 Средняя толщина более 0,8 мм. 
 Используется прозрачный материал. 
 Рисунок не монохромный. Отпечатанные на цветной поверхности метки 

не считываются. 
 Поверхность материала испачкана или измята. 
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5.2.2 AAS II для серии RX II 
 
В AAS II есть четыре схемы работы с метками: 2-Point Positioning (по 2 точкам) 

(только в режиме подачи), 4-Point Positioning (по 4 точкам), Segmental 

Positioning (по сегментам), Multiple Copies (создание копий). 

 

Перед печатью макетов на струйном принтере необходимо добавить к макету 

приводочные метки, созданные в программе для резки типа GreatCut, SCAL, SignPal 

или модуле GCC для CorelDRAW. Режущие плоттеры GCC не работают с рисунками 

и метками, сделанными от руки. 

 

Подробнее о настройке приводочных меток в программе резки см. в приложении. 

 
 

1. 2-Point Positioning (позиционирование по 2 точкам, только в режиме подачи) 
 

Простой режим, ускоряющий распознавание приводочных меток. 
 
 

 
 

2-я метка 1-я метка 
 
 
 
 
2. 4-Point Positioning (позиционирование по 4 точкам) 

Базовая схема автоматического распознавания приводочных меток в AAS II 
и контурной резки изображений внутри этих меток. 
 Команда: Esc.D1;(XDist);(YDist):Layout: 4 приводочные метки по четырем 

углам вокруг макета. 
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3. Segmental Positioning (позиционирование по сегментам) 
К четырем исходным точкам добавляются промежуточные приводочные метки 
по осям X и Y для большой точности резки, особенно крупных изображений. 
 Команда: Esc.D2;(XDist);(YDist);(XStep);(YStep): 
 Компоновка: 

Промежуточное расстояние по оси X: от 200 до 600 мм, по умолчанию 300 мм  
Промежуточное расстояние по оси Y: от 200 до 600 мм, по умолчанию 300 мм 

 

 
 

 Точная резка длинных макетов 
Для более качественных результатов плоттеры серии RX II работают 
с секционной резкой. 
- Объект обрабатывается по сегментам с учетом настроек, схемы Segmental 

Positioning. 
- Последовательность резки: Сегмент 1 > Сегмент 2 > Сегмент 3 > Сегмент 4 
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3. Multiple Copies (Создание копий) 

Функция используется для тиражирования изображений, если нужно получить 
сразу несколько экземпляров. Датчик AAS II автоматически отсканирует 
приводочные метки для каждого отдельного изображения, обеспечив точность 
резки. 

 Команда: Esc.D3;(XCopies);(YCopies);(Space): 

 Компоновка: 
 

 
 

 

5.2.3 Автоматическое определение направления макета 
Для удобства пользователей плоттеры серии RX II автоматически определяют 
направление подачи материала при контурной резке. На рис. 5-1 показана 
последовательность распознавания приводочных меток при стандартной подаче 
материала (1->2->3->4). На рис. 5-2 плоттер распознает приводочные метки (3->4->1-
>2) при подаче в обратном направлении. Плоттеры серии RX II распознают метки и 
выполняют контурную резку независимо от способа загрузки материала. 

 
Алгоритм распознавания направления: 

(См. рис. 5-2) 
 

a. Распознавание положения третьей приводочной метки 

b. Переход к четвертой приводочной метке для определения направления 

(направление распознается по четвертой приводочной метке) 

c. Перед началом резки драйвер обрабатывает информацию 

d. Метки распознаны, идет выполнение задания (последовательность распознавания 
меток 3 >4 >1 > 2) 
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Рис. 5-1 Рис. 5-2 
 

5.3 Пробная печать 
 

Перед выполнением контурной резки с системой AAS рекомендуется распечатать 
тестовый файл с установочного диска DVD, чтобы обеспечить точность реза на RX II. 
 
Для AASII предусмотрено два тестовых файла: 
1. AAS II_X_Y_Offset_Caberation_A4.eps (формат A4) 
2. AAS II_X_Y_Offset_Caberation_600_600.eps (по умолчанию, рекомендован) 
 

■ �Распечатать тестовое изображение. (На принтере с высокой точностью) 

■ �Загрузить изображение в RX II и отправить файл на резку для тестирования 

■ �Если необходимо внести корректировки, отредактировать величину смещения, 
как описано ниже: 

▶ Замерить величину смещения отпечатанной линии и линии реза. 

▶ Ввести значение AAS Offset в разделе MISC с учетом полученных значений, 
затем нажать Enter 

▶ Повторно протестировать резку 

■ Величину смещения по осям X и Y для AAS II определяют следующим образом: 

▶ Горизонтальная линия — X, вертикальная линия — Y (лицом к режущему 
плоттеру) 

▶ Если нужно сместить линию реза и отпечатанную линию по направлению 
к исходной метке, указывают отрицательное значение смещения. Если 
нужно сместить линию от исходной метки, вводят положительное значение 
смещения (см. рис. ниже). Это относится к осям X и Y. 
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Примечание 
 Перед изменением настроек AAS II выполняют масштабирование по ширине 

и длине. 
 Для тестового изображения смещение ножа не задано. Его настраивают 

в зависимости от выбранного ножа. 
 С вопросами обращаться к производителю или местному дистрибьютору. 
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5.4 Допустимое смещение приводочных меток 
Чтобы система распознала приводочные метки, необходимо следить за правильностью 
загрузки материала (по приводочной линейке на опорной пластине). При отклонениях, 
выходящих за приведенный диапазон, метки распознаны не будут. 

 

 

 
 
 

 
5.5 Контурная резка 
Для точности контурной резки с функцией AAS выполнить следующие шаги: 
Шаг 1 Создание графики 

■ Создать изображение, которое нужно отпечатать и вырезать через программу. 
 

 
 

■ Создать контур реза вокруг изображения. 
 

 
 

Совет 1. Оставлять место между изображением и контурной линией. 
Совет 2. Создавать контур в отдельном слое и присваивать ему другой цвет. 

 
■ Добавить приводочные метки вокруг изображения. 

 

Примечание 

Можно воспользоваться функцией Multiple Copies. Она автоматически копирует 
изображение и приводочные метки. 

  



10
 

AFR-24S. Руководство 

 

 

 
 

Шаг 2 Разместить приводочные метки 

 Макет в AAS: 
 

 
* Функция автораспознавания на 1-й метке охватывает серую зону. 

 Рекомендованы поля в 30 мм слева и справа от листа материала. 

 Рекомендованы поля от верхней кромки листа от 20 до 30 мм, от нижней 
кромки — не менее 50 мм во избежание падения листа и на случай ошибки 
в размерах материала. 

 

Шаг 3 Отпечатать графику 
 Отпечатать на принтере изображение и метки. 
 При печати на рулоне придерживаться следующей ориентации: 

(масштаб = 100 %).  
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Шаг 4 Загрузить отпечаток в режущий плоттер 
Исходная метка должна отличаться от остальных приводочных меток. Необходимо 
проверить правильность направления подачи. 

 

  

Шаг 5 Вырезать контур 

Через программу дать команду выполнить задание на резку. 
 
 

5.6 Советы по AAS 
Чтобы результаты контурной резки были лучше, придерживаться следующих правил. 

 Работать с простыми источниками освещения, не освещать плоттер сбоку. 

 Перед запуском системы AAS изменить максимальный формат бумаги в свойствах 
драйвера AFJ-24S. 

Шаг 1 В папке Printer & Fax на компьютере найти модель RX II. 

Шаг 2 Открыть окно Properties (Свойства) и выбрать вкладку Paper (Бумага). 

Шаг 3 Изменить максимальный размер бумаги по оси X на 1200 мм. 

 Скорость резки установить в диапазоне 300–600 мм/с. 

 Проследить, чтобы прижимные ролики не закрывали приводочные метки. 

 При распознавании приводочных меток убедиться, что материал не загнут. 
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В этом разделе рассмотрено базовое техническое обслуживание режущего плоттера, 
включая очистку. Все процедуры, не вошедшие в перечень ниже, выполняются только 
квалифицированным сервисным специалистом. 

 
 

6.1 Очистка режущего плоттера 
Необходимо регулярно и тщательно очищать режущий плоттер — от этого зависит 
качество его работы. 

 
 

 

 
 
 
Рекомендованные процедуры: 

• Осторожно протереть поверхность режущего плоттера безворсовой тканью. 
При необходимости смочить ткань водой или спиртом. Просушить и вытереть 
остатки влаги мягкой безворсовой тканью. 

• Протереть направляющие рейки каретки от пыли и грязи. 

• Удалить грязь и остатки материала из-под корпуса прижимного ролика 
с помощью пылесоса. 

• Очистить опорную пластину, датчики бумаги, прижимной ролик влажной тканью, 
смоченной в воде или в спирте и просушить мягкой безворсовой тканью. 

• Протереть стойку от пыли и грязи. 

 Меры предосторожности! 
   

Глава 6  
 

 

 Во избежание удара электрическим током, перед очисткой 
режущий плоттер отключить от розетки электросети. 

 Запрещается использовать для очистки растворители, 
абразивные чистящие средства и агрессивные моющие 
составы. Они могут повредить поверхность режущего 
плоттера и движущиеся части. 

Техническое обслуживание 
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6.2 Очистка решетчатого барабана 
 
1. Режущий плоттер отключить, каретку отодвинуть от очищаемой области. 

2. Поднять прижимные ролики и отодвинуть от решетчатого барабана. 

3. Жесткой щеткой (можно зубной) очистить поверхность барабана от пыли. 
В процессе очистки проворачивать барабан вручную (рис. 6-1). 

 

 
Рис. 6-1 

 
 

6.3 Очистка прижимных роликов 
1. Если прижимные ролики нуждаются в очистке, удалять загрязнения 

с обрезиненной части роликов следует безворсовой тканью или тупфером. Чтобы 
прижимной ролик не проворачивался при очистке, придерживать его пальцем. 

2. Въевшиеся и стойкие загрязнения удалять безворсовой тканью или тупфером, 
смоченными в медицинском спирте. 

 

 

Примечание 

Очень важно обслуживать режущий плоттер ежедневно. Для точности 
и качества резки решетчатый барабан и прижимные ролики нуждаются 
в регулярной очистке. 
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В этом разделе рассмотрены распространенные проблемы в процессе эксплуатации 
плоттера. Перед тем как знакомиться с содержимым раздела, убедитесь, что ваша 
программная среда совместима с режущим плоттером. 

 

 
 

Почему режущий плоттер не функционирует? 
 
 
 
 

Вероятные причины: 

7.1 Нарушения, не связанные с эксплуатацией 
Сначала проверить следующее: 
 Правильно ли подключен шнур питания к плоттеру? 
 Правильно ли подключен шнур питания к источнику питания? 
 Горит ли светодиодный индикатор питания? 

 
 

Решения: 
Если на дисплее отображаются сообщения, режущий плоттер исправен. 
Отключить и повторно включить режущий плоттер. Проверить, сохранилась ли 
проблема. 
 
 
Если на дисплее ничего не отображается, следует обратиться к техническим 
специалистам дилера. 

 
Примечание 
Перед тем как обращаться за техническим обслуживанием, необходимо 
убедиться, что проблема в режущем плоттере, а не в интерфейсе, в компьютере 
или в программном обеспечении. 

Глава 7  
 

 Поиск и устранение неисправностей 
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7.2 Нарушения, связанные с эксплуатацией 
К нарушениям работы могут привести механические неисправности и отказ функций. 
В сообщениях об ошибках, которые выводятся на дисплей, сначала указана 
проблема, затем рекомендованные действия. Если после выполнения 
рекомендованных действий проблема не исчезла, следует обратиться 
за техническим обслуживанием. 

 
 
 

В сообщении указывается, что проблема 
может быть по оси X. Проверить, работает 
ли барабан и правильно ли загружен 
материал. Для перезагрузки системы 
устранить нарушение и включить плоттер 
повторно. 

 
 
 

В сообщении указывается, что каретке 
может что-то мешать на оси Y. 
Для перезагрузки системы устранить 
нарушение и включить плоттер повторно. 

 
 
 

В сообщении указывается, что неисправен 
датчик опускания и поднятия ножа. 
Для перезагрузки системы отключить 
и повторно включить плоттер. Если 
проблема не исчезла, следует обратиться 
к техническому специалисту. 

 
 
 

В сообщении указывается, что область реза 
превысила лимит. Загрузить материал 
большего размера или уменьшить 
изображение. Для продолжения нажать 
клавишу на дисплее. 

Error, Check Media Or 
Drum or X Motor 

Error, Check Media 
Or Y Motor 

Error, Check Carriage 
Sensor or VC Motor 

Graph Was Clipped. 
Data In Buffer 
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7.3 Нарушения взаимодействия режущего плоттера и компьютера 
Представленные ниже сообщения указывают на нарушения взаимодействия 
режущего плоттера и компьютера. 

 
 

  
 
 
 
 
 

 
 
 

  
 
 
 

 
 
 

Если режущий плоттер не распознает 
команды HP-GL/2 или HP-GL, 
проверить правильность применения 
команд HP-GL/2 или HP-GL к режущему 
плоттеру. 

Примечание 
Настроенные параметры обмена данными для компьютера должны быть 
совместимы с требованиями плоттера. 

См. описание клавиши MISC 
в разделе 3 «Описание 
действий при настройке 
порта». 

Проверить взаимодействие 
режущего плоттера 
и компьютера. Если плоттер 
по-прежнему не работает, 
следует обратиться к 
техническому специалисту. 

Соединительный кабель правильно 
подключен к режущему плоттеру 
и компьютеру? 

 
Да 

  
Нет 

 

Communication Error 
Setup: MISC. key 

HP-GL/2 Cmd. Error 

См. раздел 2 
«Подключение режущего 
плоттера». 

Интерфейс настроен 
правильно? 

 
Да 

  
Нет 
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См. раздел 2 
«Подключение 
режущего 
плоттера». 

Использовать 
рекомендован-
ный кабель 

Требуется ли 
для 
программного 
обеспечения 
другой кабель? 

Да Не
 

 

7.4 Отказ программных средств 
Сначала проверить следующее: 

 
 

Пакет программ совместим с вашим компьютером 
и режущим плоттером? 
Программное обеспечение поддерживает драйвера HP-
GL и HP-GL/2? (* проверить конфигурацию программы.) 

 
Да 

  
Нет 

 

  
 
 
 
 
 
 
 
 
 
 

 
 
 

  

Необходимо устранить 
сообщение об ошибке 
на дисплее или обратиться 
к поставщику ПО. 

Отключить и повторно 
включить плоттер, еще 
раз отправить файл. 

Практически во всех известных 
программах резки есть драйверы 
для наших режущих плоттеров. 
Если их нет, в программе 
с поддержкой эмуляции HP-GL 
и HP-GL/2 выбрать один из трех 
драйверов: 
 Формат A3: HP7475A 
 Формат A1: HP7580A 
 Формат A0: HP Draf Pro Exl или 

HP Draf Master 

Интерфейс режущего плоттера 
отвечает требованиям 
программного обеспечения? 

 
Да 

  
Нет 

 

Предоставил ли 
разработчик ПО 
тестовый файл? 

 
Да 

  
 

 

Нет 
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Отрегулировать усилие реза для 
оптимального давления ножа. 
См. «Усилие реза и регулировка 
смещения» 

 

7.5 Снижение качества резки 
 

 
 
 
 
 
 
 
 

 
 

 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 

 
 

  
 
 
 
 
 

 
 
 

 
 
 
 
 
 

 
 

 

Примечание. Очень важно обслуживать режущий плоттер ежедневно. Для 
точности и качества резки решетчатый барабан и прижимные ролики нуждаются 
в регулярной очистке. 

См. раздел  
«Установка ножа» 

Заменить 
нож новым 

Отрегулировать 
смещение инструмента. 

Извлечь 
и очистить нож. 

Обратиться за технической 
поддержкой к дилеру. 

Правильно ли установлен нож и надежно ли 
закреплен держатель ножа? 

 

Да 

  
Нет 

 
Нож тупой или 
сколотый? 

 

Да 

  

Нет 

 
Усилие установлено верно? 
(Усилие реза по умолчанию 
80 г) 

 

Да 

  

Нет 

 
Смещение инструмента 
настроено верно? 

 
Да 

  
Нет 

 
Нож загрязнен? 

 

Да 

  

Нет 
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Технические характеристики A-1 

 

 

 

А-1 Технические характеристики 
 

Элемент Описание 

Автоматический финишер (режущий плоттер с автоподатчиком) 

 
Форматы материала 

A4 (297 x 210 мм), SRA4 (320 x 235 мм), A3 (297 x 420 мм), SRA3 
(320 x 450 мм), B3 (500 x 353 мм) (альбомная ориентация) 
Дополнительно: B2 (500 x 707 мм) 

A3+ (329 x 483 мм) (книжная ориентация) 

Интерфейс USB 2.0 (полноскоростной), последовательный (RS-232C), Ethernet 
Источник питания От 100 до 240 В переменного тока (три источника питания) 

Эксплуатационные условия 
Температура: от +15 до +30 °C 
Относительная влажность: от 25 до 75 % (конденсация 
не допускается) 

Габариты (плоттер 
с податчиком) 

Около 1098 (Ш) x 1140 (Г) x 782 (В) мм 
(плоттер необходимо установить на краю стола) 

Масса Около 47,5 кг (плоттер: 25,5 кг, автоподатчик: 22 кг) 

Режущий плоттер (J5-61LX Creasing) 

Скорость реза, не более 1530 мм/с (под углом 45°) 

Ускорение, не более 4,2 G 

Усилие реза, не более 600 гс 

Интерфейс USB 2.0 (полноскоростной), последовательный (RS-232C), Ethernet 

Источник питания От 100 до 240 В переменного тока 

Энергопотребление, 
не более 

251,8 Вт 

Автоподатчик 

Форматы материала 
Ширина: от 279 до 500 мм; длина: от 210 до 500 мм 
До 350 г/м2 

Емкость подающего лотка 250 листов плотностью до 150 г/м2
 или высотой до 50 мм 

(зависит от материала, толщины и состояния) 

Интерфейс Последовательный (RS-232C) 

Источник питания Блок питания сетевой, выходное напряжение от 100 до 240 В 
переменного тока, выходная мощность около 60 ВА 

• Совместимость с ОС Windows 7 и выше, MAC OS X 10.6 и выше. (* При приобретении серийного 
номера ПО Sure Cuts A Lot, работающего с Mac OS.) 
 

• GCC оставляет за собой право на изменение технических характеристик без предварительного 
уведомления. 
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Технические характеристики ножей A-2 

 

 

 

А-2 Технические характеристики ножей 
 

 
 

265019700G 

Для толстой флуоресцентной и витринной тонировочной пленки. 
Также для работ из стандартного винила с мелкими деталями. 

 Характеристики ножа: 45°, красная насадка, смещение 0,25 мм, 
диаметр лезвия 2,5 мм 

 

 
 
 

265017540G 

Для резки светоотражающего винила, картона, пескоструйных 
материалов, флока, острых краев трафарета. 

 Характеристики ножа: 60°, зеленая насадка, смещение 0,50 мм, 
диаметр лезвия 2,5 мм 

 

 
 
 

265017550G 

Для резки тонких пескоструйных масок и шаблонов. Особая 
конструкция и острый угол заточки для контуров с малыми 
радиусами. 

 Характеристики ножа: 60°, синяя насадка, смещение 0,25 мм, 
диаметр 2,5 мм. 

 

 
 
 

265017560G 

Для резки мелкого текста и сложных деталей. Острый 
нож с минимальным смещением. 

 Характеристики ножа: 50°, черная насадка, смещение 0,175 мм, 
диаметр лезвия 2,5 мм 

 

 
 
 

265017530G 

 
Для тонких и хрупких материалов, включая витринные 
тонировочные пленки. 

 Характеристики ножа: 25°, желтая насадка, смещение 0,25 мм, 
диаметр лезвия 2,5 мм 
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Технические характеристики ножей A-2 

 

 

 
 

Об инструменте 
Общий термин, обозначающий нож для резки листов, перо для графопостроения 
и светодиодный прицел (дополнительно) для наведения на точку привязки. 
СМЕЩЕНИЕ — расстояние, на которое сдвинуто лезвие ножа относительно 
центральной линии ножа. 

 
 
 
 
 

Нож 
 
 
 
 
 
 
 
 

 

 
 

Лезвие ножа 
Центральная линия 

 

смещение 
 
Вылет ножа 

 
 
 
 
 
 

Вылет ножа 

Толщина 
материала 
(t1) 

 
Толщина бумаги-
основы (t 2) 

 
 
 
 

Вылет, то есть высота, на которую выступает лезвие ножа = t1 + t 2/ 2. Для удобства 
можно считать, что это от 0,3 до 0,5 мм от края держателя. 
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Вывод из CorelDRAW A-3 

 

 

 
 

 
A-3 Инструкция по выводу из CorelDRAW 
Ниже описана процедура вывода файла из CorelDRAW. 

 

Инструкции для пользователя 
 

1. Открыть CorelDRAW, закончить редактирование всех файлов для вывода 
и выбрать сразу все изображения. 

 
2. Командой Outline Pen задать контур для резки. 

 

 
 

3. Установить значение ширины пера на 0,001 мм и подтвердить кнопкой ОK. 
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Вывод из CorelDRAW A-3 

 

 

 
 

 
4. Командой File > Print (Файл > Печать) отправить файл на режущий плоттер. 

 

 
 
 
 

5. Выбрать установленную модель. 
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Вывод из CorelDRAW A-3 

 

 

 
6. На вкладке Layout для опции Reposition images to выбрать вариант: → Bottom left 

corner (Выравнивание по левому нижнему углу). 
Внимание: изображение должно находиться в нижнем левом углу. 

 

 
 
 

7. Вернуться на вкладку General и проверить, чтобы изображение было в нижнем 
левом углу. Нажать Print (Печать) и получить прекрасно вырезанное изделие. 
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Модуль CorelDRAW A-4 

 

 

 
 

 
А-4 Инструкция по модулю CorelDRAW 
Программа установки AASII VBA работает с CorelDRAW версий 13, 14, 15, 16, 17, 18 

 

Установка 
Установка программного модуля AAS дляCorelDRAW описана в шаге 8 раздела 2.1.1.1 
«Установка драйвера» (стр. 15). 

 
Запуск программного модуля CorelDRAW AAS 

 

Шаг 1 Запустить CorelDRAW для редактирования графики и выделить сразу все 
изображения для отправки на плоттер. 

 
Шаг 2 Запустить макрос командой ToolsMa cros Run Ma cro. В меню Macros in выделить 

опцию Global Macros (GCCAASII_Draw13.gms) и нажать Run (Выполнить). 
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Модуль CorelDRAW A-4 

 

 

 
 

 

Шаг 3 Нажать Apply (Применить) и указать тип приводочных меток — по размеру страницы 
или по объекту. 

 
 

     

Шаг 4 Теперь можно распечатывать файл с приводочными метками. 
 

 
 
Для модуля AAS можно добавить значок быстрого запуска 

 

Выполнить Tools  Options  Workspace  Customization  Commands  Macros  

GCCModule.GCC_AAS_Plug_In и нажать OK. 
 

  

Примечание При щелчке на изображении по умолчанию выбирается опция 
Add Registration Mark by Object (Добавлять приводочные метки по объекту). 
При щелчке на пустой области страницы по умолчанию выбирается опция 
Add Registration Mark by page size. 
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Добавление приводочных меток по странице 
 

Если установить флажок Add Registration Mark by page size и нажать Apply программа 
автоматически создаст приводочные метки (рис. A3-1). 

  
 

Рис. A3-1 
 

Рис. A3-2 
 
 
При перемещении изображения программа создает 4 метки на углах страницы, как 
показано ниже. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 Рис. A3-3  

Примечание 
1. Длина в пределах от 5 до 25 мм, в зависимости 

от размера страницы. 

 
2. После добавления приводочных меток по 

странице, как показано ниже,НЕ ДОПУСКАЕТСЯ 
внесение изменений в раздел Origin во 
избежание смещения меток (см. рис. A3-2). 
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Рабочая область 
Позволяет редактировать и вырезать изображения за границами приводочных меток при 
условии добавления меток по странице. 

 
Для материалов A4 рабочая область на 2,5 мм заходит за приводочные метки с правой 
и левой сторон, на 4,5 мм — за верхнюю метку. Рекомендованное расстояние до нижнего 
края материала — не менее 25 мм во избежание падения листа и на случай ошибки 
в размерах материала. 

 
Для материалов формата A3 рабочая область на 10 мм заходит за приводочные метки 
с левой стороны, на 9 мм — с правой стороны, на 11 мм — за верхнюю метку. 
Рекомендованное расстояние до нижнего края материала — не менее 25 мм 
во избежание падения листа и на случай ошибки в размерах материала. 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

 

Примечание Для размотки рулона выбрать режим Edge при настройке формата 
материала. При работе в режиме Single лист материала нельзя переместить 
назад, а значит, фронтальный датчик бумаги его не распознает. 
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Добавление приводочных меток по объекту 
 

При установке флажка «Add Registration Mark by Object»на выбор доступно три варианта 
приводочных меток. 

  4-Point Positioning (по 4 точкам) 

  Length: длина меток 

 Диапазон: от 5 до 50 мм 

  Оптимально: 25 мм 

 Thickness: толщина линии меток 

 Диапазон: от 1 до 2 мм 

 Оптимально: 1 мм 

 Margin: расстояние между метками и изображениями 

 Диапазон: от 0 до 50 мм 

 Оптимально: 5 мм 
 
 

Segmental Positioning (по сегментам) 

 X Step: расстояние промежуточного положения по оси X 

 Y Step: расстояние промежуточного положения по оси Y 

 Диапазон: от 200 до 600 мм 

 Оптимально: менее 500 мм 
 
 
 
 
 

Рис. A3-4 

Multiple Copies (создание копий) 

 No. of X Copies: количество копий по оси X 

 No. of Y Copies: количество копий по оси Y 

 Диапазон: от 1 до 50 (чем больше копий, тем больше 

времени нужно на передачу данных). 

 Количество копий X * количество копий Y = общее 

количество копий изображения 

 Сopies with outline: для отображения контуров 
изображения 

 
 
 
 

 

Примечание Значения, указанные в разделе 4-Point Positioning (длина, толщина, 
поля), действительны также с установленными флажками Segmental Positioning 
и Multiple Copies. 
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Позиционирование по 4 точкам 
 
 

4-Point Positioning 

 Length: длина меток 

 Диапазон: от 5 до 50 мм 

 Оптимально: 25 мм 

 Thickness: толщина линии меток 

 Диапазон: от 1 до 2 мм 

 Оптимально: 1 мм 

 Margin: расстояние между метками и изображениями 

 Диапазон: от 0 до 50 мм 

 Оптимально: 5 мм 
 
 
 
 
 
 
 

Рис. A3-5 
 
 
Программа создаст 4 метки, как показано на рисунке ниже. 

 

 
 

Рис. A3-6 
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Примечание 
1. Для экономии материала при позиционировании по 4 точкам допускается менять 

не только поля объекта, но и длину приводочных меток (не менее 5 мм). 
Рекомендации для различных форматов см. в таблице 1. Чем меньше размер, тем 
меньшим должно быть расстояние между объектом и приводочной меткой 
(см. расчеты ниже). 

 
 
 
 
 

Область реза 
 
 
 

Рис. A3-7 Рис. A3-8 
 
 
 
 
 
 

Формат страницы, мм Рекомендуемая длина метки, мм 

A6 (105 × 148) 5 
А5 (148 × 210) 8 
А4 (210 × 297) 11 
А3 (297 × 420) 16 
А2 (420 × 594) 23 
А1 (594 × 841) и более 25* 

Таблица 1 
*25 мм — рекомендованная длина приводочной метки 

 

2. Размер приводочных меток влияет на точность распознавания, поэтому не следует 
делать их слишком мелкими 

 
3. При изменении формата бумаги необходимо указать новые значения для 
приводочных меток, иначе применяются текущие настройки. 
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Позиционирование по сегментам 
 
 

 

Для высокоточной резки рекомендуется выбрать режим 
Segmental Positioning, повысив точность обработки длинных 
и крупноформатных изображений. 

 
 
 
 
 

Позиционирование по сегментам 

 X Step: расстояние промежуточного положения по оси X 

 Y Step: расстояние промежуточного положения по оси Y 

  Диапазон: от 200 до 600 мм 

 Оптимально: менее 500 мм 
 
 
 
 

Рис. A3-9 
 
 
Программа создаст метки, как показано на рисунке ниже. 

 
 

 
 

Рис. A3-10 
 
При копировании объектов больших размеров (длина либо ширина более 200 мм) 
с функцией Multiple Copies к ним применяется позиционирование по сегментам — 
для более точного распознавания приводочных меток. 

По сегментам 
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Multiple Copies (Создание копий) 
Переключатель Multiple Copies повышает точность реза в случаях, когда из материала 
необходимо получить несколько экземпляров одного изображения. 

 
 
 
 
 
 
 
 

Multiple Copies 

 No. of X Copies: количество копий по оси X 

 No. of Y Copies: количество копий по оси Y 

 Диапазон: от 1 до 50 (чем больше копий, тем больше 

времени нужно на передачу данных). 

 Количество копий X * количество копий Y = общее 

количество копий изображения 

 Сopies with outline: для отображения контуров изображения 
 
 

Рис. A3-11 
 

 
Программа создаст результат, как показано на рисунке ниже. 

 

 
Рис. A3-12 

Ось Y 

Ось X 
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Контурная резка через CorelDraw 
 
Шаг 1 Поместить в плоттер GCC бумагу с приводочными метками, отпечатанными 
на принтере. 
 
Шаг 2 Выполнить Files  Print. 
 

 

 
 

Рис. A3-13 
 

 
Примечание Для CorelDraw версии Х5 и выше выполнить описанные ниже шаги. 
 

 

Шаг 1 На вкладке Color в поле Color conversions performed by: (Выполнить 
преобразование цвета в:) указать модель плоттера (см. рис. А3-14). 
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Рис. A3-14 
 
 
 
 
 
 
 
 
 
 
 
 
Шаг 2 На вкладке Layout для опции Reposition images to выбрать вариант Bottom left corner 

(Выравнивание по левому нижнему углу). Нажать кнопку Print. 

   Рис. A3-15 
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А-5 Инструкция по модулю Illustrator 
 
Установщик AASII VBA работает с Adobe Illustrator версий CS4, CS5, CS6, CC. 

 

Установка 
Установка программного модуля AAS для Adobe Illustrator описана в шаге 8 раздела 
2.1.1.1 «Установка драйвера» (стр. 15). 

 
Настройка принтера 

 

Шаг 1 Открыв окно принтеров через Панель управления, щелкнуть правой кнопкой 
мыши на принтере и выбрать Printer Properties. Откроется диалоговое окно свойств 
принтера. 
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Шаг 2 Убедиться, что на вкладке Advanced (Дополнительно) снят флажок Enable 
advanced printing features (Включить дополнительные возможности печати). 
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Инструкции для пользователя 
 

Шаг 1 Открыть Illustrator. 
 

Шаг 2 Отредактировать изображение, создав контурную обводку. (Примечание. Ширину 
линии установить на 0,001 мм). 

 

 
 
 

Шаг 3 Щелкнув на изображении, применить функцию AAS (FileScripts_AASII_Plug_In). 
 

 

 

Линия 
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Шаг 4 Выделить нужные приводочные метки. 
 

 
 

Шаг 5 Здесь доступны три типа приводочных меток: 4-Point Positioning (по 4 точкам), 
Segmental Positioning (по сегментам), Multiple Copies (создание копий). 

 

 
 

 

Примечание 
Значения, указанные в разделе 4-
Point Positioning (длина, толщина, 
поля), действительны также с 
установленными флажками 
Segmental Positioning и Multiple 
Copies. 
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Шаг 6 Подтвердить приводочные метки (далее в примере рассмотрено 
позиционирование по 4 точкам). 

 
 

Шаг 7 Щелкнув на пустой области страницы, выбрать Document Setup (Настройка 
документа). 
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Шаг 8 Нажать Edit Artboards (Редактировать монтажные области). 
 

 
 

Шаг 9 Выполнить Presets → Fit Artboard to Artwork bounds (Подогнать монтажную область 
по выбранной иллюстрации). 
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Шаг 10 После шага 9 навести мышь на панель инструментов слева и выбрать инструмент 
выделения Selection Tool. 

 

 
 
 
Шаг 11 Режим редактирования снова активен. 
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Шаг 12 Распечатать файл с линией контура и приводочными метками. 
 

 
 
 
Шаг 13 Поместив отпечаток в плоттер, ослабить прижимные ролики и подвести каретку 

к приводочным меткам. 
 
Шаг 14 Отправить файл на плоттер. 
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Шаг 15 Выбрав плоттер, поместить объект в левом нижнем углу. 
 

 
 

Шаг 16 Работа завершена. 
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Добавление приводочных меток по странице 
Чтобы создать метки приводки по размеру страницы, следует выделить объект, 
выполнить команду Scripts из меню File и выбрать AASII_Plug_In. 

 

 
 

 

Примечание 
Длина метки составляет от 10 до 50 мм, в зависимости от размера страницы. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Установив флажок Make by page size, нажать Apply 
(Применить). В четырех углах страницы создаются 

метки приводки, как показано ниже. 
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Рабочая область 
Позволяет редактировать и вырезать изображения за границами приводочных меток при 
условии добавления меток по странице. 

 
Для материалов A4 рабочая область на 2,5 мм заходит за приводочные метки с правой 
и левой сторон, на 4,5 мм — за верхнюю метку. Рекомендованное расстояние до нижнего 
края материала — не менее 25 мм во избежание падения листа и на случай ошибки 
в размерах материала. 

 
Для материалов формата A3 рабочая область на 10 мм заходит за приводочные метки 
с левой стороны, на 9 мм — с правой стороны, на 11 мм — за верхнюю метку. 
Рекомендованное расстояние до нижнего края материала — не менее 25 мм 
во избежание падения листа и на случай ошибки в размерах материала. 

 
 

 

Примечание Для размотки рулона выбрать режим Edge при настройке формата 
материала. При работе в режиме Single лист материала нельзя переместить 
назад, а значит, фронтальный датчик бумаги его не распознает. 
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Добавление приводочных меток по объекту 
 

При добавлении приводочных меток по объекту на выбор доступно три варианта. 
 

Выделив изображение, которое нужно обозначить метками, выполнить команду Scripts 
из меню File и выбрать AASII_Plug_In. 

 
Флажок Make by page size следует снять, а затем указать нужный тип приводочных меток. 
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Три типа приводочных меток 
 

Позиционирование по 4 точкам 
 
 
 
 

4-Point Positioning 
 Length: длина меток 
 Диапазон: от 5 до 50 мм 
 Оптимально: 25 мм 

 Thickness: толщина линии меток 
 Диапазон: от 1 до 2 мм 
 Оптимально: 1 мм 

 Margin: расстояние между метками и 
изображениями 
 Диапазон: от 0 до 50 мм 
 Оптимально: 5 мм 

 
 
 
 
 
 
 
 
 
 
 

Программа создаст 4 метки, как показано на рисунке ниже. 
 

 



Модуль Illustrator A-5 

AFR-24S. Руководство 
 

 

 

Примечание 
1. Для экономии материала при позиционировании по 4 точкам допускается менять 

не только поля объекта, но и длину приводочных меток (не менее 5 мм). 
Рекомендации для различных форматов см. в таблице 1. Чем меньше размер, тем 
меньшим должно быть расстояние между объектом и приводочной меткой (см. 
расчеты ниже). 

 
 

Область реза 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Формат страницы, мм Рекомендуемая длина метки, мм 

A6 (105 × 148) 5 
А5 (148 × 210) 8 
А4 (210 × 297) 11 
А3 (297 × 420) 16 
А2 (420 × 594) 23 
А1 (594 × 841) и более 25* 

Таблица 1 
*25 мм — рекомендованная длина приводочной метки 

 

2. Размер приводочных меток влияет на точность распознавания, поэтому не следует 
делать их слишком мелкими 

 
3. При изменении формата бумаги необходимо указать новые значения для 
приводочных меток, иначе применяются текущие настройки. 
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Позиционирование по сегментам 
Для точной резки рекомендуется выбрать режим Segmental Positioning, повысив 
точность обработки длинных и большеформатных изображений. 

 
 
 
 

Segmental Positioning 
 X Step: расстояние промежуточного положения по 

оси X 
 Y Step: расстояние промежуточного положения по 

оси Y 
 Диапазон: от 200 до 600 мм 
 Оптимально: менее 500 мм 

 
 
 
 
 
 
 
 
 
 

Программа создаст метки, как показано на рисунке ниже. По сегментам  
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Создание копий 
Переключатель Multiple Copies повышает точность реза в случаях, когда из материала 
необходимо получить несколько экземпляров одного изображения. 

 
 
 
 
 
 
 

Multiple Copies 
 No. of X Copies: количество копий по оси X 
 No. of Y Copies: количество копий по оси Y 
 Диапазон: от 1 до 50 (чем больше копий, тем 
больше времени нужно на передачу данных). 
 Количество копий X * количество копий Y = 
общее количество копий изображения 

 Сopies with outline: для отображения контуров 
изображения 

 Margin: расстояние между метками; должно 
быть 0 или ≧ 20; отрицательные значения не 
допускаются 

 
 
 
Программа создаст результат, как показано на рисунке ниже. 

 

 

Ось X 

Ось Y 
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А-6 Инструкция по модулю GreatCut 
Руководство пользователя программного модуля GreatCut доступно на установочном 
DVD-диске GCC. 

 

Система GCC AASII 
Ниже приведена пошаговая инструкция по работе с функцией AAS в программе 
GreatCut через CorelDRAW и Adobe Illustrator. 

 
 

Редактирование изображений в CorelDRAW 
 
 
 
 

Позиционирование по 4 точкам 
Шаг 1 Создать новый файл в CorelDRAW. Нажать на значок Create contour (Создать 

контур) на панели GreatCut — появится автоматически после запуска CorelDRAW. 
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Шаг 2 Настроить параметры контура, включая смещение контура, и подтвердить кнопкой 
Calculate (Расчет). 

 

  
 
 

К изображениям будут добавлены контурные линии. 
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Совет Закругленный контур для векторного объекта 
 

Функция Outline (Контур) повышает качество обработки векторных объектов. 
На острых углах заметна разница между вариантами Normal (Стандарт) и Round 
(Со скруглением). См. рис. ниже: 

 

  
 

Стандарт Со скруглением 

1. Кнопкой Create outline создать вокруг текстовых объектов контуры на свободно 
задаваемом расстоянии. 

 

  
 
 

2. Выбрать Round corners и указать параметры Offset и Tolerance. 
Offset — расстояние между внутренним и внешним контуром исходного объекта. 
В поле Tolerance указано, на каком расстоянии от угловой точки скругляется 
срез. 
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Шаг 3 Нажать значок Settings на панели инструментов GreatCut. 
 

 
 
 
Шаг 4 Нажать кнопку справа от поля Jog marks. 
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Шаг 5 В окне настройки указать размер, расстояние до объекта и толщину линий 
приводочных меток и подтвердить кнопкой ОК. 

Позиционирование по 4 точкам 
 Size: длина меток 
 Диапазон: от 5 до 50 мм 
 Оптимально: 25 мм 

 Object margin: расстояние 
между метками 
и изображениями 
 Диапазон: от 0 до 50 мм 
 Оптимально: 5 мм 

 Line thickness: толщина линии 
меток 
 Диапазон: от 1 до 2 мм 
  Оптимально: 1 мм 

 
 
 

Шаг 6 Убедиться, что установлены все три флажка ниже, и нажать ОК. 
 

 

 
 
 

 
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Шаг 7 Нажать значок Set Jog Marks на панели инструментов GreatCut. 
 

 
 
 
Программа создаст 4 метки, как показано на рисунке ниже. 
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Примечание 
1. Для экономии материала при позиционировании по 4 точкам допускается менять не 

только поля объекта, но и длину приводочных меток (не менее 5 мм). 
Рекомендации для различных форматов см. в таблице 1. Чем меньше размер, тем 
меньшим должно быть расстояние между объектом и приводочной меткой (см. 
расчеты ниже). 

                                                                                                  

 
 
 

Формат страницы, мм Рекомендуемая длина метки, мм 

A6 (105 × 148) 5 
А5 (148 × 210) 8 
А4 (210 × 297) 11 
А3 (297 × 420) 16 
А2 (420 × 594) 23 
А1 (594 × 841) и более 25* 

Таблица 1 
*25 мм — рекомендованная длина приводочной метки 

 

2. Размер приводочных меток влияет на точность распознавания, поэтому не следует 
делать их слишком мелкими 

Область реза 
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Вывод 
Шаг 1 Выбрать объект целиком, включая приводочные метки и линию контура, и нажать 

значок Cut на панели инструментов GreatCut. 

 

Шаг 2 Система автоматически активируется и запустит импорт приводочных меток 
и линии контура в GreatCut. 
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Шаг 3 Из меню File выбрать команду Output (Вывод). 
 

 
 
 

Шаг 4 В окне выбора устройства Output to device в поле Mode/Tool указать Cut with AAS. 
 

 

Указать остальные параметры: 
AAS Offset, Pressure, Speed, 
Material width и пр. 
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Шаг 5 Нажать Output — объект будет отправлен на режущий плоттер GCC. 
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Примечание Разница между параметрами Number of outputs, Number of copies и Step 
count в окне Output. 

 

 
 

 

 

 

 

 

1. Значение параметра Number of outputs — 2: квадрат и треугольник 
вырезаются 1 раз, а затем обе фигуры вырезаются 1 раз в следующей 
позиции. 

 
2. Значение параметра Number of copies — 2: квадрат и треугольник вырезаются 

2 раза в той же позиции. 
 

3. Значение параметра Step count — 2: квадрат вырезается 2 раза в одной 
позиции, треугольник вырезается 2 раза в одной позиции. 
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Расширенная настройка 
 

Позиционирование по сегментам 
Для точной резки рекомендуется выбрать режим Segmental Positioning, повысив качество 
обработки длинных и большеформатных изображений. 

 
Для настройки линии реза и создания приводочных меток повторить шаги из раздела 
Позиционирование по 4 точкам. В окне настройки указать размер, расстояние от меток 
до объекта, толщину линий приводочных меток, расстояние между метками 
и подтвердить кнопкой ОК. 

 
Шаг 1 Нажать значок Settings на панели инструментов GreatCut. 
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Шаг 2 Нажать кнопку справа от поля Jog marks. 
 

 
 
 

Шаг 3 В окне настройки указать размер, расстояние до объекта и толщину линий 
приводочных меток и подтвердить кнопкой ОК. 

 
 
 
 
 
 

Позиционирование по сегментам 
 Max. X Distance: расстояние 

промежуточного положения 
по оси X 

 Диапазон: от 200 до 500 мм 
 Max. Y Distance: расстояние 

промежуточного положения 
по оси Y 

 Диапазон: от 200 до 500 мм 
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Шаг 4 Убедиться, что установлены все три флажка ниже, и нажать ОК. 
 

 
 
 
Шаг 5 Нажать значок Set Jog Marks на панели инструментов GreatCut. 

 

 

 
 
 

 
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Программа создаст метки, как показано на рисунке ниже. 
 
 
 

Позиционирование по сегментам 
 
 
 
 
 
 

Ось Y 
 
 
 
 
 
 
 
 

Ось X 
 
 
Для отправки файла на режущий плоттер GCC повторить шаги из раздела Вывод. 

 
 
 

Создание копий 
 

Шаг 1 Для настройки линии реза и создания приводочных меток повторить шаги из раздела 
Позиционирование по 4 точкам. 

 
 
 
 
 
 
 
 

При работе с функцией 
Multiple Copies 
применяются параметры, 
указанные в этом разделе. 
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Шаг 2 Нажать значок Set Jog Marks на панели инструментов GreatCut: будут созданы 
4 метки, как на рисунке ниже. 
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Шаг 3 Выбрать объект целиком, включая приводочные метки и линию контура, 
и нажать значок Cut на панели инструментов GreatCut. 

 
 

Шаг 4 Система автоматически активируется и запустит импорт приводочных меток 
и линии контура в GreatCut. 
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Шаг 5 Из меню File выбрать команду Output (Вывод). 
 

 
 
 
Шаг 6 В поле Mode выбрать Cut with AAS, указать количество изделий по осям X и Y, 

расстояние между копиями. Кнопку Output не нажимать. 

 
 
Шаг 7 Вернуться в CorelDRAW. Выполнить File > GreatCut > Multi-Copy. 
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Шаг 8 Указать параметры Number in X/Y (количество копий по осям X и Y), расстояние 
Distance in X/Y (расстояние между копиями). Нажать ОК. Убедиться, что значение 
Distance in X/Y совпадает с указанным в шаге 6. 

 

 
 
 
Примечание Расстояние по горизонтали и вертикали (Offset X & Y) должно быть ≥ 20 мм 

или = 0 мм. Рекомендуется устанавливать параметр Distance in X/Y на 0 мм, чтобы 
не делать промежутков между копиями для экономии материала. 

 
Шаг 9 Программа создаст насколько копий объекта с приводочными метками, как 

показано на рисунке ниже. 
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Шаг 10 Отпечатать копии изображений, материал с отпечатками загрузить в режущий 
плоттер GCC. 

 

 
 

Шаг 11 В окне GreatCut нажать кнопку Output. 
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Редактирование изображений в Adobe Illustrator 
 

Позиционирование по 4 точкам 
 

Шаг 1 Создать новый файл в Adobe Illustrator. 
 

 
 
Шаг 2 Выбрать изображение и выполнить File > GreatCut > Contour. 
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Смещение контура — расстояние 
между объектом и линией 
контура. 

 

Шаг 3 Настроить параметры контура, включая смещение контура, и подтвердить кнопкой 
Calculate (Расчет). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

К объекту добавлена линия контура. 
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Совет Закругленный контур для векторного объекта 
 

Функция Outline (Контур) повышает качество обработки векторных объектов. 
На острых углах заметна разница между вариантами Normal (Стандарт) и Round 
(Со скруглением). См. рис. ниже: 

 

  
 

Стандарт Со скруглением 

1. Выполнить File > GreatCut > Outline, создав вокруг текстовых объектов 
контуры на свободно задаваемом расстоянии. 

  
 
 

2. Выбрать Round corners и указать параметры Offset и Tolerance. 
Offset — расстояние между внутренним и внешним контуром исходного объекта. 
В поле Tolerance указано, на каком расстоянии от угловой точки скругляется 
срез. 
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Шаг 4 Выполнить File > GreatCut > Settings. 
 

 
 

Шаг 5 Нажать кнопку справа от поля Jog marks. 
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Шаг 6 Указать размер, расстояние до объекта и толщину линий приводочных меток 
и подтвердить кнопкой ОК. 

 

4-Point Positioning 
 Size: длина меток 
 Диапазон: от 5 до 50 мм 
 Оптимально: 25 мм 

 Object margin: расстояние 
между метками 
и изображениями 
 Диапазон: от 0 до 50 мм 
 Оптимально: 5 мм 

 Line thickness: толщина линии 
меток 
 Диапазон: от 1 до 2 мм 
 Оптимально: 1 мм 

 
 
 
 
Шаг 7 Убедиться, что установлены все три флажка ниже, и нажать ОК. 
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Шаг 8 Выполнить File > GreatCut > Set Jog Marks. 
 

 
 
 
Программа создаст 4 метки, как показано на рисунке ниже. 
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Вывод 
Шаг 1 Выбрать объект целиком, включая приводочные метки и линию контура, 

и выполнить File > GreatCut > Cut. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Шаг 2 Система автоматически активируется и запустит импорт приводочных меток 

и линии контура в GreatCut. 
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Шаг 3 Из меню File выбрать команду Output (Вывод). 
 

 
 

Шаг 4 В окне выбора устройства Output to device в поле Mode/Tool указать Cut with AAS. 
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Шаг 5 Нажать Output — объект будет отправлен на режущий плоттер GCC. 
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Примечание Разница между параметрами Number of outputs, Number of copies и Step 
count в окне Output. 

 
 

 
 

 
1. Значение параметра Number of outputs — 2: квадрат и треугольник 

вырезаются 1 раз, а затем обе фигуры вырезаются 1 раз в следующей 
позиции. 

 
2. Значение параметра Number of copies — 2: квадрат и треугольник вырезаются 

2 раза в той же позиции. 
 

3. Значение параметра Step count — 2: квадрат вырезается 2 раза в одной 
позиции, треугольник вырезается 2 раза в одной позиции. 
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Расширенная настройка 
 

Позиционирование по сегментам 
Для точной резки рекомендуется выбрать режим Segmental Positioning, повысив качество 
обработки длинных и большеформатных изображений. 

 
Для настройки линии реза и создания приводочных меток повторить шаги из раздела 
Позиционирование по 4 точкам. В окне настройки указать размер, расстояние от меток 
до объекта, толщину линий приводочных меток, расстояние между метками 
и подтвердить кнопкой ОК. 

 
Шаг 1 Выполнить File > GreatCut > Settings. 
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Шаг 2 Нажать кнопку справа от поля Jog marks. 
 

 
 
 
Шаг 3 Указать размер, расстояние до объекта и толщину линий приводочных меток 
и подтвердить кнопкой ОК. 

 
 
 
 
 
 
 

Segmental Positioning 
 Max. x Distance: расстояние 

промежуточного положения 
по оси X 

 Диапазон: от 200 до 500 мм 
 Max. y Distance: расстояние 

промежуточного положения 
по оси X 

 Диапазон: от 200 до 500 мм 



AFR-24S. Руководство 

Модуль GreatCut A-6 

 

 

 

Шаг 4 Выполнить File > GreatCut > Set Jog Marks. Будут созданы 4 метки, как на рисунке 
ниже. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ось Y 
 
 
 
 
 
 
 
 
 
 

Ось X 

По сегментам 
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Создание копий 
 

Шаг 1 Для настройки линии реза и создания приводочных меток повторить шаги из раздела 
Позиционирование по 4 точкам. 

 
 
 
 
 
 
 
 

При работе с функцией 
Multiple Copies применяются 
параметры, указанные 
в этом разделе. 

 
 
 
 
 
 
 
Шаг 2 Выполнить File > GreatCut > Set Jog Marks. Будут созданы 4 метки, как на рисунке 

ниже. 
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Шаг 3 Выбрать объект целиком, включая приводочные метки и линию контура, 
и выполнить File > GreatCut > Cut. 
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Шаг 4 Система автоматически активируется и запустит импорт приводочных меток 

и линии контура в GreatCut. 
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Шаг 5 Из меню File выбрать команду Output (Вывод). 
 

 
 
 
Шаг 6 В поле Mode выбрать Cut with AAS, указать количество изделий по осям X и Y, 

расстояние между копиями. Кнопку Output не нажимать. 

 



Модуль GreatCut A-6 

AFR-24S. Руководство 
 

 

 

Шаг 7 Вернуться в Adobe Illustrator. Выполнить File > GreatCut > Multi-Copy. 
 

 
 
 
Шаг 8 Указать параметры Number in X/Y (количество копий по осям X и Y), расстояние 

Distance in X/Y (расстояние между копиями). Нажать ОК. Убедиться, что значение 
Distance in X/Y совпадает с указанным в шаге 6. 

 

 
 
 
Примечание Расстояние по горизонтали и вертикали (Offset X & Y) должно быть ≥ 20 мм 

или = 0 мм. Рекомендуется устанавливать параметр Distance in X/Y на 0 
мм, чтобы не делать промежутков между копиями для экономии материала. 
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Шаг 9 Программа создаст насколько копий объекта с приводочными метками, как 
показано на рисунке ниже. 

 

 

Шаг 10 Отпечатать копии изображений, материал с отпечатками загрузить в режущий 
плоттер GCC. 
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Шаг 11 В окне GreatCut нажать кнопку Output. 
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А-7 Инструкция по SignPal 12 
Программа SignPal 12 совместима с ОС Windows. Все версии поддерживают функцию 
контурной резки AAS II. 

 
Инструкция по SignPal 12: содержание 
[1] Установка программного обеспечения SignPal 12 
[2] Настройка плоттера GCC через Production Manager  
[3] Начало работы с SignPal AASII 
[4] Перечень функций SignPal 12 

 
[1] Установка программного обеспечения SignPal 12 
Для установки программы необходимы права Администратора (Administrator). Для работы 
с программой необходимы права Опытного пользователя (Power User). Подробнее 
в руководстве пользователя Windows. 

 
1. Удалить предыдущие версии программы, если они есть. 

 
2. Открыть сайт GCC Club (http://gccf.gcc.com.tw/gccclub/login.aspx), войти в систему 

выполнить Drivers > Cutter > Others > SignPal 12, чтобы загрузить файл WinRAR. 
 

 

 
 
3. Установить и активировать SignPal 12, выполнив перечисленные ниже шаги. 

http://gccf.gcc.com.tw/gccclub/login.aspx
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(1)  Установка и активация ПО на компьютере с интернет-подключением 
 

1. В адресной строке браузера ввести https://www.saicloud.com, нажать Enter. Ввести 
код активации и нажать Activate. Код активации находится на этикетке программного 
обеспечения. 

 
 

 
 

2. При входе в систему выбрать I am new to the SAi Cloud и указать адрес электронной 
почты. Нажать Create Account. На указанный адрес будет отправлено сообщение. 

 
 

 

https://www.saicloud.com/
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3. Найти сообщение в почтовом ящике и щелкнуть по ссылке в письме. Заполнить 
поля для информации. 
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4. С помощью WinRAR запустить из архива файл Autorun. Установить программу, 
следуя подсказкам мастера установки. 
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5. Вставить код в поле для кода активации. 
 

  
 

6. Выбрать нужный язык, нажать OK и завершить установку. 
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(2) Установка и активация ПО на компьютере без интернет-подключения 
 
1. С помощью WinRAR запустить из архива файл Autorun. Установить программу, 

следуя подсказкам мастера установки. 
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2. Записать идентификационный код компьютера из диалогового окна ниже. Найти имя 
вашего компьютера. Для этого правой кнопкой мыши щелкнуть на значке Мой 
компьютер и выбрать Свойства. 

 

  
 

3. На другом компьютере с интернет-подключением открыть браузер и набрать в 
адресной строке браузераhttps://www.saicloud.com. Подтвердить клавишей Enter. 
Ввести код активации и нажать Activate. Код активации находится 
в сертификате программного обеспечения. 

 
 

 

https://www.saicloud.com/
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4. При входе в систему выбрать I am new to the SAi Cloud и указать адрес 
электронной почты. Нажать Create Account. На указанный адрес будет отправлено 
сообщение. 

 

 
 
 

5. Найти сообщение в почтовом ящике и перейти по ссылке в письме. Заполнить 
поля для информации. 
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6. Нажать License Manager can’t connect? (Диспетчер лицензий не может 
подключиться?). Указать код компьютера и имя компьютера, которое вы записали 
ранее. Нажать Create License Now (Создать лицензию) и Download License 
(Загрузить лицензию), сохранить файл на компьютер. 
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7. Скопировать файл лицензии на компьютер без интернет-подключения с диска, 

импортировать его. 
 

 
 

 
 

8. Выбрать нужный язык, нажать OK и завершить установку. 
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(3) Перенос лицензии на компьютере с интернет-подключением 
 

1. Открыть License Manager из меню Start. 
 

 
 

2. Выбрать Remove License From This Computer (Удалить лицензию с этого 
компьютера). Теперь программное обеспечение можно установить на другой 
компьютер. 
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(4) Перенос лицензии на компьютере без интернет-подключения 
1. Открыть License Manager из меню Start. 

 

 
 

2. Выбрать Remove License From This Computer. Ввести код деактивации в диалогом 
окне License. 

 

 

3. На компьютере с интернет-подключением запустить браузер, зайти на 
https://www.saicloud.com и войти в свою учетную запись. Выбрать License 
Removed (Лицензия удалена), ввести код деактивации и нажать Remove. Теперь 
программу можно установить на другой компьютер.  

  

https://www.saicloud.com/
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[2] Настройка плоттера GCC через Production Manager 

 

1. Открыть Production Manager 12 
2. Выбрать и настроить режущий плоттер GCC 

(Система AAS II работает только с моделями RX II, Jaguar V LX, Puma III, Expert II LX.) 
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AFR-24S. Руководство 

Инструкция по SignPal 12 A-7 

 

 

 

3. В программе SignPal выполнить File > Print Setup и выбрать принтер. 
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4. В программе SignPal выполнить File > Document Setup и указать формат бумаги. 

 

 
 

 



AFR-24S. Руководство 

Инструкция по SignPal 12 A-7 

 

 

 
 

 

[3] Начало работы с SignPal AASII 
 

1. С помощью инструмента Rectangle создать прямоугольник. 
 

 
 

2. Выполнить Effect > Contour Cut. В окне DesignCentral нажать Apply (Применить). 
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3. Применить метку контурной резки GCC AASII, выполнив Effect > Contour Cut Mark. 

 

 
 
 
4. В окне SignPal DesignCentral выбрать GCC AASII, чтобы создать приводочные метки 

AAS II (позиционирование по 4 точкам). Подтвердить кнопкой Apply. 
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5. Есть три варианта приводочных меток GCC AAS II: 4-Point Positioning (по 4 точкам), 

Segmental Positioning (по сегментам), Multiple Copies (создание копий). Для 
позиционирования по сегментам в окне DesignCentral выбрать GCC Segmentation 
и нажать Apply. 

 

 
 

6. Создание копий в SignPal недоступно. На текущий момент воспользоваться функцией 
копирования можно только через модуль для CorelDraw. 

 
7. Для вывода изображения выполнить File > Print. 
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8. В окне Print (Печать) установить значение Scale (Масштаб) равным 100 %. 

 

 
 
 
9. Загрузить в плоттер винил и отправить данные командой File > Cut Contour. 

На вкладке Properties (Свойства) диалогового окна Cut Contour доступен 
предварительный просмотр задания. Здесь же можно изменить параметры резки. 
Система Production Manager автоматически активируется для выполнения задачи. 
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[4] Перечень функций SignPal 12 

 
 Эксперт Новичок 
Текст 
Работа с текстом ● ● 

Текст по дуге ●  

Текст по кривой ●  

Вертикальный текст ● ● 

По вертикальной кривой ●  

Кернинг ●  

Разделить/Объединить ● ● 

Рисование 
Кривые Безье ● ● 

Свободное рисование ● ● 

 
Фигуры 
Прямоугольник ● ● 

Овал ● ● 

Приводочные метки ● ● 

Размеры ● ● 

Редактировать кривую 
Выбрать точку ● ● 

Удалить точку ●  

Добавить точку ●  

Выпрямить кривую ●  

Скруглить угол ●  

Заострить угол ●  

Оптимизировать по кривой ●  

Оптимизировать по дуге  

 

 

Оптимизировать по 3 точкам 
 

●  

Создать дугу ●  

Сократить число точек ●  

Замкнуть кривую ●  

Изменить начальную точку ●  

Разделить ●  

Ножницы ●  
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Создать прямой угол ●  
Разорвать кривую ●  
Соединить кривые ●  
Выровнять по 

 
●  

Выровнять по вертикали             ●  
Выровнять точки ●  
Применить длину и угол ●  
Удалить мелкие объекты ●  
Векторный ластик ●  
Разделить по кривой ●  

 
Работа с файлами 

Информация по заданию ●  
Сканирование ●  
Выйти в облако ● ● 
Рабочие области ● ● 

Вид 
DesignCentral ● ● 
Цветовой микшер ● ● 
Захват ● ● 

 
Упорядочивание 
Сгруппировать ● ● 
Объединить ● ● 
Маскировать ● ● 
Направляющие ● ● 
Контурная резка ● ● 
Перевести в кривые ● ● 
Преобразовать 
элементы в 

 

● ● 

Преобразовать 
связанные 

  

● ● 

Направление кривой ● ● 
Упорядочить ● ● 
Порядок резки ● ● 
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Выровнять ● ● 
Расстояние ● ● 

Повернуть ● ● 
Изменить размер ● ● 

Убрать перекос ● ● 

Зеркально отобразить ● ● 

Многократно копировать ●  

Эффекты 
Комбинирование ●  

Контур ●  

Контурная резка ● ● 

Метка контурной резки ● ● 

Тень ●  

 
Растр 
Автотрассировка ●  

Цветовой режим ●  

Производство 
Резать/рисовать ● ● 

Ручное разделение линий ● ● 

Упорядочить все копии ● ● 

Монтировать до границы ● ● 

Автоматическое слияние ● ● 

Автоматический треппинг ● ● 

Нахлест ● ● 

Оптимизация порядка резки 
 

● ● 
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А-8 Программа Sure Cuts A Lot 
Ниже приведены базовые сведения по работе с программой Sure Cut A Lot. За более 
подробной информацией обращаться к справочным файлам Sure Cut A Lot. 

 
1. Выбрать нужный принтер и изменить рабочую область. 

Шаг 1 Запустить программу Sure Cuts A Lot. 
 

  
 
 
Шаг 2 Для изменения рабочей области в меню Cutter выбрать My Cutter, затем 

Manage Cutters. 
 

А 
 
 

Шаг 3 В списке компаний и марок выбрать GCC и нужную модель, нажать кнопку 
Add to list. 
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Шаг 4 Слева выбрать GCC и нажать Done. 
 

 

Шаг 5 Чтобы изменить размер и ориентацию рабочей области, нужно ввести 
соответствующие значения в окне Document (Документ). 

 

 
 
 

2. Вставка изображения из библиотеки 
 

Шаг 1 Для вставки выбрать в библиотеке нужный файл с изображением. 
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3. Добавление текста 
Нажав на значке T слева, в текстовом окне ввести текст и выбрать нужный шрифт. 

 

 
 

4. Импортирование макета 
Макет из другой графической программы импортируют командой Import или Place image 
из меню File. SCA поддерживает форматы svg, scut, scal, pdf, ai. eps, png и wpc. 

 

 
 
 

Совет Тысячи файлов SVG специально для Sure Cuts A Lot! 
 http://SVGCuts.com  — лучший ресурс для создания дизайнов в формате 

SVG. Тысячи элементов в высоком качестве: шаблоны для открыток, 
скрапбукинга, подарочных пакетов, коробок, объемных цветов. 

http://svgcuts.com/
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5. Преобразование изображения в файл реза 

Шаг 1 Открыть окно настройки, выполнив Trace Image (Трассировка изображения) 
из меню File или нажав кнопку Trace Image на панели инструментов. 

 

 
 
 

Шаг 2 Импортировать изображение кнопкой Choose an image, указать настройки 
изображения (Image Settings) и вывода (Output Settings) и нажать OK. Программа 
автоматически создаст контур изображения. 

 
 
 

 

Примечание 
 На результаты трассировки влияют контрастность и пиксели. 

Предпочтительно импортировать файлы с высокой контрастностью. 



Программа Sure Cuts A Lot A-8 

AFR-24S. Руководство 
 

 

 

6. Резка макета 
 

Шаг 1 Нажав кнопку Cutter на панели инструментов, открыть диалоговое окно настроек. 
 

 
 
 
Шаг 2 Нажав кнопку Settings…, открыть диалоговое окно GCC Cutter Settings. 

 

 
 

 
 
Шаг 3 В окне GCC Cutter Settings при необходимости отрегулировать приводочные метки. 

 

 
 

 

*Приводочные метки: настроить расстояние между кромкой материала 
и приводочными метками в поле Mark Offset; размер меток — в поле 
Mark Size; толщину линий — в поле Mark Thickness. 

Примечание 
 Исходная точка находится справа внизу. 
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Шаг 4 При необходимости задать настройки Blade Offset, Overcut Value, Multi-Cut и Quality 
в окне Cut Settings. 

 

 
 
 

 

*Blade Offset (Смещение ножа): задается с учетом типа ножа; 
для стандартного ножа составляет 0,25 мм, для дополнительного 
улучшенного ножа — 0,5 мм, для дополнительного пера — 0 мм. 

 
*Quality (Качество): чем выше качество, тем ниже скорость 

обработки. 

 
*Multi-Cut (Несколько проходов): для повторного выполнения 

задания из той же позиции при резке толстого материала. 

 
*Overcut (Нахлест): упрощает отделение облоя и компенсирует 

незамкнутые линии реза. 
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Шаг 5 В разделе Cut Settings предусмотрен ряд полезных функций. Задав нужные 
параметры, данные отправляют на режущий плоттер GCC кнопкой Cut. Плоттер 
начинает работу. 

 

 
 
 
 

 

*Cut Mode (Режим резки): параметры WYSIWYG и Origin Point. 
Режим WYSIWYG — плоттер выводит изображение точно так же, 
как в окне предварительного просмотра. В режиме Origin Point 
(Исходная точка) плоттер начинает резку с левой верхней точки 
материала. 

 
*Use Software Speed and Pressure (Программные скорость 

и давление): установите флажок, чтобы вручную задать 
параметры скорости и давления. 

 
*Preset (Предварительные настройки): программа автоматически 

задает скорость и давление реза для выбранного материала. 

 
*Speed & Pressure (Скорость и давление): для повышения 

качества можно настраивать вручную скорость и давление реза. 
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7. Печать и резка макета 

Функция Print and Cut позволяет отпечатать изображение из программы Sure Cuts A Lot 
на принтере, а затем загрузить материал с распечаткой в режущий плоттер GCC и через 
Sure Cuts A Lot вырезать по контуру. 

 
Шаг 1 Открыть файл с изображением в программе Sure Cuts A Lot. 

 

 
 
Шаг 2 Выбрать значок плоттера (Cutter) на панели инструментов, задать нужные 

параметры. Кнопкой Print+Cut добавить приводочные метки и распечатать 
изображение. 
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Шаг 3 Нажав Print…, открыть окно настроек принтера, выбрать OK. 
 

 
 
 
Шаг 4 Распечатать макет с наружными приводочными метками. 

 

 
 
 
Шаг 5 Загрузить запечатанный материал в режущий плоттер GCC. 

 

Шаг 6 Нажать Next, затем Scan+Cut. Плоттер GCC распознает приводочные метки 
и автоматически вырежет контурные линии. 
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Совет  Как экономить материалы с функцией Test Connection. 
 Нажать кнопку Test Connection, чтобы проверить соединение. 
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8. Резка по цвету *только в моделях RXII и RXII (Creasing) 
 
Резка по цвету позволяет задать несколько параметров для 16 разных цветов в 
макете. Это упрощает работу с различными заданиями. 

 
 

Шаг 1 Для изменения рабочей области в меню Cutter выбрать My Cutter, затем GCC 
RXII-CR. 

 

 
 
 
 
Шаг 2 Импортировать дизайн или вставить графическое изображение из библиотеки. 
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Шаг 3 Щелкнуть на нужной области и выбрать цвет пера в соответствии с цветом 
обводки для настраиваемого на следующем шаге параметра. Нажать ОК. 

 

 
  

 
 

Шаг 4 Кнопкой  открыть окно Edit Presets (Редактировать предустановленные 
настройки)со значениями по умолчанию для разных материалов. 
Отредактировать параметры и сохранить изменения кнопкой ОК. 
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Шаг 5 Нажав кнопку Cutter на панели инструментов, открыть диалоговое окно настроек 

Cut Settings. 
 
 

 
 
 
 

Шаг 6 Нажать Cut By Color (Резка по цвету), затем нажать кнопку «Cut», и плоттер 
начнет работу. 
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9. Биговка *только в моделях RXII (Creasing) 
 

Модель RX II-61 (Creasing), укомплектованная двойными держателями для 
биговочного инструмента и ножа, качественно выполняет в параллельном режиме биг 
и резку коротких тиражкй упаковочной и заказной продукции. 
(PS. Рекомендован картон плотностью от 200 до 350 г/см2. Плотность бумаги 
может варьироваться в зависимости от типа и толщины.) 

 
 
Шаг 1 Для изменения рабочей области в меню Cutter выбрать My Cutter, затем GCC 

RXII-CR. 
 

 
 
 
 
Шаг 2 Импортировать дизайн или вставить графическое изображение из библиотеки. 
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Шаг 3 Для биговки выбрать контур для бигования, установить тип линии на Draw (Pen), 
тип инструмента — 2 (left-Creasing). Кнопкой  открыть окно Edit Presets 
(Редактировать предустановленные настройки) со значениями по умолчанию 
для разных материалов. Отредактировать параметры и сохранить изменения 
кнопкой ОК. 

 

  
 
 
Шаг 4 Для резки выбрать соответствующий контур, установить тип линии на Cut 

(Резка), тип инструмента — 1 (right). Кнопкой  открыть окно Edit Presets со 
значениями по умолчанию для разных материалов. Отредактировать 
параметры и сохранить изменения кнопкой ОК. 
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Шаг 5 Нажав кнопку Cutter на панели инструментов, открыть диалоговое окно настроек 

Cut Settings. 
 
 

 
 
 
 

Шаг 6 Нажать Cut By Color (Резка по цвету), затем нажать кнопку «Cut», и плоттер 
начнет работу. 

 
 

 
 


